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Thank you for choosing this YASKAWA ELECTRIC AMERICA software product.  Proper 
installation and use of this software will ensure proper product performance, and will prevent 
damage to connected inverter products. 
 
Please read this manual thoroughly before using this software product and operate the software 
and any connected inverter products with care. 
 
Please refer to the inverter product operation manual for proper handling and care of any 
connected inverter. 
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NOTICE 

 
1. This manual describes the functions of the product and relations with other 

products.  You should assume that anything not described in this manual is not 

enting the product, please contact your 
YASKAWA ELECTRIC AMERICA representative if you have any suggestions
on improving this manual. 

3. The inverter product contains potentially dangerous parts under the cover. Do 
not attempt to open the cover under any circumstances. Doing so may result in 
injury or death and may damage the product. Never attempt to repair or 
disassemble the product.  

4. We recommend that you add the following precautions to any instruction 
manuals you prepare for the system into which the product is being installed or 
incorporated. 
• Precautions on the dangers of high-voltage equipment. 
• Precautions on touching the terminals of the inverter product even after 

power has been turned OFF. (These terminals are live even with the power 
turned OFF.) 

5. Specifications and functions may be changed without notice in order to improve 
product performance. 

possible. 
2. Although care has been given in docum
  
  

tems to Check Before Unpacking 
heck the following items before removing the product from the package: 
• Has the correct product been delivered (i.e., the correct model number and specifications)? 
• Has the product been damaged in shipping? 
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Notice: 
YASKAWA ELECTRIC AMERICA products are created and manufactured 
for use according to proper procedures by a qualified operator and only for the 
purposes described in this manual. 
 
The following conventions are used to indicate and classify precautions in this 
manual. Always heed the information provided with them. Failure to heed 
precautions can result in injury to people or damage to property. 

 
DANGER indicates an imminently hazardous situation which, if not avoided, will 
result in death or serious injury. 

 
WARNING indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury. 
 
Caution indicates a potentially hazardous situation which, if not avoided, may result 
in minor or moderate injury, or property damage. 

 
  
YASKAWA Product References: 

All YASKAWA and YASKAWA ELECTRIC AMERICA products are 
capitalized in this manual. 

 
The abbreviation “PC” means Personal Computer, and is not used as an abbreviation for 
anything else. 
 
 
 

 
 

© YASKAWA ELECTRIC AMERICA, 2006 
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, 
or transmitted, in any form, or by any means, mechanical, electronic, photocopying, recording, or 
otherwise, without the prior written permission of YASKAWA ELECTRIC AMERICA. 
 
No patent liability is assumed with respect to the use of the information contained herein. 
Moreover, because YASKAWA ELECTRIC AMERICA is constantly striving to improve its 
high-quality products, the information contained in this manual is subject to change without 
notice. Every precaution has been taken in the preparation of this manual. Nevertheless, 
YASKAWA ELECTRIC AMERICA assumes no responsibility for errors or omissions. Neither 
is any liability assumed for damages resulting from the use of the information contained in this 
publication.
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Introduction 
 
This chapter provides the introduction to DriveWizard™ 
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Introduction to DriveWizard™ 
  
  
 DriveWizard™ is a PC software program designed to provide the 
installation, parameter record keeping, and maintenance as simpl
features are provided:  
 
• Upload and retrieve parameter data from a drive or file 
• View and modify drive data with a simple user interface  
• Download and save such data to a drive or file 
• Ability to save parameter or graph data as comma separated var

other software applications such as Microsoft EXCEL  
• Comparison of drive parameter values to saved values or compa
• Online monitoring for troubleshooting and diagnostic purposes 
• Fault History 
• Digital scope feature for graphing drive data  
• Basic online control of the drive to test parameter adjustments, 

perform motor auto-tunes.  
• Supports GPD515/G5, E7, F7, G7, GPD305/J7, P7, and GPD31

Electric manufactured AC drives. 
• Supports off-line editing of the drive parameters stored in files o
• Supports multiple databases for special drive software’s  
• Contains parameter conversion tools to convert one drive family

drive family. Example: GPD515/G5 parameter file to an F7 par
 
 
 
This manual describes the DriveWizard™  environment and how to
describe how to use each feature in greater detail.  
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 Introduction to DriveWizard™

New Features for DriveWizard™ 6.1 
  
• G5 to G7 File Conversion Tool. 

This feature allows the user to convert a previously saved standard G5 drive 
DriveWizard™  parameter file into a standard G7 drive DriveWizard™ parameter file.   
 

• GPD505/P5 & GPD506/P5+ to E7 & P7 Conversion Tool. 
This feature allows the user to convert a previously saved standard GPD505/P5 or 
GPD506/P5+ drive parameter file in InverterWin 3.0 into a standard E7 or P7 
DriveWizard™ drive parameter file.  
 

• Enhanced Ethernet drive multiple IP address storage. 
This feature allows the user to create a list of IP addresses as long as they wish to select a 
drive to connect to in Ethernet communications.  The drives can also have a tag name up 
to 32 characters associated with it’s IP address to easily find a particular drive in a long 
list of IP addresses. 
 

• Support for Ethernet Modbus TCP/IP and Ethernet/IP 
Both Ethernet protocols are now supported in DriveWizard™. 
 

•  Drive Write Protect added. 
This feature allows the user to set a password and enable the write protect function.  
When this function is turned on, the user of DriveWizard™ can only monitor the drive, 
view drive parameters, and upload parameters from the drive.  You cannot change any 
parameters, download parameter files, initialize the drive, reset the drive, or utilize 
RunWizard. 
 

• Drive Remote Reset Capability 
The ability to reset a drive fault while on-line with DriveWizard™ has been added. 
 

• E7+ / P7+ Database 
This additional database supports the new featured E7+  4010 software and the P7+ 1020 
software’s. 
 

• Standard G7 CASE database 
This feature adds G7 CASE support by additional DriveWizard™  database supplied with 
the software. 
 

• V7 Ethernet Database 
This feature adds GPD315/V7  support for Ethernet when using a CMO9x 
communications option for GPD315/V7 by an additional DriveWizard™   database 
supplied with the software. 
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Installation and Start 
up 

 
This chapter describes the installation process of DriveWizard™ 
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 Minimum Requirements

 

Minimum Requirements 
 
 
Minimum PC requirements for DriveWizard™  

 
The following are the minimum PC requirements for DriveWizard™  

• Pentium 200MHZ Processor 
• 64Mb RAM 
• 40 Mb Free disk space (100 Mb for all databases installed) 
• RS 232 serial port 
• CD ROM drive 
• 800 x 600 pixel / 256 color display 
• Mouse 
• Microsoft Windows 2000, Windows 98, Windows NT SP4 or greater, 

Windows XP Professional operating systems. Windows 95 will work but is no 
longer actively supported. 

• Microsoft Java Virtual Machine Version 2919 dated 10/23/00 or later. (it is 
usually included in Internet Explorer 5 (VM for IE5)or greater). Version 
5.00.3802 is required for Windows XP support. 

• For using the Help Function of DriveWizard™ , you must have Internet 
Explorer 4.01 or greater installed along with the Microsoft HTML help viewer 
files. If you have Windows 98, 2000, XP, or NT SP4 the help viewer is part of 
your O/S installation.  Windows 95 and ME users may have to install the help 
viewer files by executing the hhupd.exe .  This self-extracting file is available 
on CD4005, on www.yaskawa.com, or on the Microsoft Web site. 
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Installation 
  
Installing the DriveWizard™ PC Software 

 
 
When installing a newer version of DriveWizard it is recommended that you 
first uninstall the previous version and re-boot your PC to make sure the 
installation executes correctly. 
 
 

� 
Note! 

Installation

 
To install DriveWizard™, please follow these steps below based on the source of the 
DriveWizard™ program: 
 
• From a Yaskawa CD-ROM 

1. Close all open programs currently running on the PC to prevent interference with 
the installation process. 

2. Insert the CD-ROM into the CD-ROM drive (the D: drive for example). 
3. If "Autoplay" is enabled, the CD-ROM will automatically start when the CD-

ROM is inserted. The CD ROM main navigation menu will appear in a new 
window on the PC display. Click on the Software menu button and select the 
DriveWizard™ PC support tool item . 

4. If "Auto play" is not enabled, a manual method may be used to start installation 
once the CD-ROM is inserted in the PC CD-ROM drive.  
o Open the Windows Explorer and click on drive D.  
o Use the path D:\Software\DriveWizard5\Install DW to find the installation file 
o Double click on the install icon to start the installation (If the CD-ROM drive 

is not D: , replace D: with the appropriate CD-ROM drive letter). The 
installation program will start and a welcoming screen will appear.  

 
• From the yaskawa.com Website. 

1. Go to http://www.yaskawa.com/site/products.nsf/products/Industrial AC 
Drives~DriveWizardTM.html 

2. Click on the Download section. 
3. You have two choices to download the main program: a single file (if you have a 

fast internet connection) or multiple files (for you modem users). Select the zip 
file(s) to download and save them to a folder on your hard drive. 

4. Unzip the files.  If you have elected to download the multiple files version, be 
sure to unzip all of the files into 1 folder. 

5. Close all open programs currently running on the PC to prevent interference with 
the installation process. 

6. In the folder that you unzipped the files you will find an icon called Install.exe.  
Double click this icon to start the installation. The installation program will start 
and a welcoming screen will appear. 
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 Installation

 
 
 
 
 
 
 

The welcoming screen 
will look like this. 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
A message will appear, welcoming you to 
the DriveWizard™  program. 
Click     Next   to continue. 

 
 
 
 
 

 
 
 

 
The next screen is the Yaskawa Electric 
America software license Agreement.  You 
must accept the terms to proceed with the 
installation.  
 
A warning window will pop up indicating 
that you must choose the custom installation 
for support of non-standard drives. Click    
OK  to continue. (See Table 2.1 on next 
page) 
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 Installation

 
You can choose 3 types of setups: 
Typical: Which installs DriveWizard™, the 
standard drives database, and DriveWizard™ 
Help. 
Compact: Which installs DriveWizard™ and 
the standard drives database 
Custom: Which allows the user to select 
which databases and features to install. (See 
Table 2.1 on next page) 

 
 

 

� 
Note!

 
To utilize the multiple database feature of DriveWizard™ you must choose 
the Custom installation option 
 
 

 
 
 
If custom installation is checked, this 
window appears.  It shows there are 4 
additional databases that can be 
installed with the standard drives 
database (see Table 2-1). 
 
 
 

 
 
 

Database Name Description 
Standard DriveWizard™ Database Covers G5, G5+, E7, F7, G7, J7, P7, &  V7 factory 

standard software’s only 
G5+ HHP 1PU Covers the special G5+ one module HHP application 
G5 HHP 450A (old) & (new) 
(two databases) 

Covers the G5 HHP standard and variable torque 
software 

V7 with DeviceNet Covers the V7N drive with built-in DeviceNet 
communications. 

G5 & F7 Generic Case G5+ and F7 with CASE special software installed 
G7 Generic Case G7 with CASE special software installed 
V7 NEMA 4X Covers V7 in Standard NEMA 4X package 
V7N NEMA 4X Covers V7 DeviceNet in Standard NEMA 4X package
E7+ and P7+ Covers E7 VSE10401x and P7 VSP10102x 
V7 with Ethernet Covers V7 VSP018340 and VAP018350 for CMO91 

and CMO93 V7 Ethernet communications kits 
Table 2.1: Database Description Summary 
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 Installation

 
 
 
 
Select the program group to create the 
DriveWizard™ icon. "Drive Wizard" is 
the default setting. After selecting the 
program group or folder, click  Next    
to continue. 

 
 
 

 
 
 
 
 

 
 
 
 
 
Then the PC files are copied from the 
CD-ROM. The percentage of the copying 
that has been completed is shown. 

 
 

 
 
 

 
 
 
 
 
 
If DriveWizard™ has been successfully 
installed, the following dialog box is 
displayed.  Click  Finish  to complete the 
setup. 
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During installation occasional errors can occur, especially in laptop 
computers that will prevent DriveWizard™ from installing correctly.  Two 
of the most common errors are: license.dat file error and –119 data move 
error. 
 These errors are caused when the installation program cannot install 
some of the active X components on the computer.  The typical causes of this 
are: 
1. Other programs running on the PC that are interfering with the 
installation process. Check the task manager to be sure that no other 
programs are running.  Check that other device support software’s have 
closed down their communications tasks and background programs 
especially if you have any other drive or PLC support products loaded on the 
PC. 
2.  Another program is using another version of one of the active X programs 
used by DriveWizard™ such as spread.ocx or strip.ocx.   
 

 
 
Uninstalling the DriveWizard™ PC Software 

 
It is recommended that you uninstall a previous version of DriveWizard™ before 
installing the newer version. To uninstall DriveWizard™, please follow these steps 
below: 
 

1. From the Windows Start menu, select Control Panel > Add/Remove Programs 
 
 
 
 
 
 
 
 
 
2. Select DriveWizard™ from the list of programs 

 
 

 
 

� 
Note! 

Installation
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 Installation

 
 

3. Click on the   Change/Remove  button.  The warning window comes up to ask 
you if you what to remove DriveWizard™.  Click on  Yes  to proceed. 

 

 
 
 

4. The uninstall program will run and uninstall all of the DriveWizard™ programs 
and add-on databases.  When it is finished, click on  OK  to end the uninstall 
process. 
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Chapter 

3 
 
 
 
 

Getting Started 
 
This chapter describes how to start DriveWizard™  
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 Connecting the PC

 

Connecting the Drive to the PC. 
 
 The following procedure concerns the easiest method of connecting your PC to the drive. 
This method utilizes the PC’s serial port and the keypad port of the drive. Please refer to Chapter 
2: Communications Menu for a complete description of connection methods. 
 Connecting the PC to the drive will depend on which model of drive you are working 
with (see Fig 3.1).  The following paragraphs describe how to connect your Yaskawa drive to 
your PC. Please refer to the correct model of drive: 
 

CIMR-G7 U 20P4 
 

      G7: Drive type 
     U: USA standard spec 
     A: Japanese standard spec 
     E: European standard spec 

 
Figure 3.1: Example of Drive Model Number 

 
GPD515/G5, G5-HHP: 

1. Remove the operator keypad.  
2. Connect cable P/N UWR00103-1 to the connector for the drive keypad (1CN). Be careful of 

the small 12 pin connect as it is keyed (2 ridges on 1 side match the two slots on the right 
hand side of the connector). 

3. Connect the 9 pin D-sub-miniature to the PC serial port. 
 
GPD315/V7, V7N, and V7 NEMA 4: 

1. Remove the operator keypad. (refer to manual TM.V7.01 page 138) 
2. Connect cable P/N UWR00468-2 to the connector for the drive keypad (1CN).  
3. Connect the 9 pin D-sub-miniature to the PC serial port. 

 
GPD305/J7 

1. Remove the option port cover. (refer to Manual TM.J7.01 page 50) 
2.  Install serial interface adapter P/N SI-232/J7 in the port 
2. Connect cable P/N UWR00468-2 to the connector on the serial interface adapter.  
4. Connect the 9 pin D-sub-miniature to the PC serial port. 
5.  Check that the drive Modbus address parameter  (n070) and the address parameter in the 

DriveWizard™ communication setup window are set to the same number. 
 
E7, F7, G7, P7: 

1. Remove the operator keypad.  
2. Connect cable P/N UWR00468-2 to the connector for the drive keypad (1CN).  
3. Connect the 9 pin D-sub-miniature to the PC serial port. 
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Starting DriveWizard™ 
 
The following section describes how to start DriveWizard™ . 
 
1.   Check to ensure the drive is on and the communication cable is connected per the prior section on 

connecting the drive to the PC. 

2. Click on the  DriveWizard™ icon      
 
3. The initial main screen will appear after the program finishes loading (Figure 3.2). 
 

 
 

Figure 3.2: Initial Main Screen 
 

 
During the program start you may have a message from the Windows 
operating system indicating that the Micosoft Java Virtual machine is 
missing or a software feature is not supported.  The program start will then 
be aborted. If this happens you must install a version of Microsoft Java 
Virtual Machine that supports all of the features of Drive Wizard.  A copy of 
the correct version of Microsoft Java Virtual Machine is included on the CD-
ROM or is available on drives.com web page.  
 Windows XP currently DOES NOT ship with JVM and JVM is not 
available from Microsoft.com.  It is available from drives.com .  Also, the 
JVM from Sun Microsystems DOES NOT WORK WITH 
DRIVEWIZARD™ 

 
Important ! 

Starting DriveWizard™
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Upgrading the version of the Microsoft Java Virtual machine may affect 
other applications installed on your computer. Please check your other 
applications if they require Microsoft Virtual Java Machine and if so, which 
version is required. 
 
 

� 
Note!

Starting DriveWizard™

If you are starting DriveWizard™  for the first time, the communications set-up window will 
appear (Figure 3.3) as the software is loading. Keep the serial communications selection under 
communication method (factory default). Unless you have altered the drive settings and have 
another device connected to COM1, accept the default settings by clicking on  OK . 

 

 
      

 
 
 

Instal
 

To insta  t
computer, 
 

1. Close all open programs currently running on the PC to prevent interference with the 
installation process. 

2. Insert the Yaskawa CD-ROM into the CD-ROM drive (the D: drive for example. 
3. If "Autoplay" is enabled, the CD-ROM will automatically start when the CD-ROM is inserted. 

The CD ROM navigation menu will appear in a new window on the PC display.  Select the 
appropriate installation under the Microsoft Virtual Machine heading. 

4. If "Autoplay" is not enabled, use the following method to start installation once the CD-ROM 
is inserted in the PC CD-ROM drive: 
• Open the Windows Explorer.  Click on drive D and double click on file folder VM. 

Select either the Win2000 if you have Windows 2000 or others for Windows 95, 98, ME, 
or NT. Double click on the msjavx86 icon to start the installation.  (If the CD-ROM drive 
is not D: , replace D: with the appropriate CD-ROM drive letter). 

Figure 3.3: Communications Setup Window 

ling the Microsoft Virtual Machine 

ll he Microsoft Java Virtual Machine from the DriveWizard™  CD-ROM onto your 
please use the following procedure: 
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On Windows 2000 you must have service pack 2 installed for this version of 
Microsoft Virtual Machine to install correctly. SP2 for Windows 2000 is 
included on the DriveWizard™ CD. 
 
 

� 
Note! 

Starting DriveWizard™

 
To install the Microsoft Java Virtual Machine from the drive.com website onto your 
computer, please use the following procedure: 

 
1. Go tohttp://www.yaskawa.com/site/products.nsf/products/Industrial AC 

Drives~DriveWizardTM.html  
2. Click on the Download section. 
3. Click on the Microsoft JVM link to download the file msjavx86.exe. 
4. Double click on the msjavx86.exe.to run the installation program. 

 
. 
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 Selecting a Database

 

Selecting a Database 
 
 In order for DriveWizard™ to communicate with the drive the database that 
DriveWizard™  utilizes must be correct for the specific software inside the drive.  DriveWizard™ 
uses the database to correctly map parameters for the particular drive(s) supported, set the 
monitor scaling correctly for the given drive type & size, and set up the proper communications 
with the drive. 
 Because of the numerous drive types and special software’s created for customers and 
applications, it was necessary to utilize multiple databases for DriveWizard™ .  In most instances 
the standard database will work with your drive but if you have a special drive or a special 
application/machine, you will have to select a database specific for that drive/application. 

DriveWizard™  has the ability to add special databases to the list that is shipped 
with the standard software.  These databases are self-installing that will automatically 
add the new database to the existing list.  The additional databases can be found 
at/on the following: 

• On the Internet athttp://www.yaskawa.com/site/products.nsf/products/Industrial AC 
Drives~DriveWizardTM.html under the download section. 

• CD.AFD7.01 
• CD.V7J7.01 
• CD.E7.01 
• CD.DW.01 

 
The installation files are contained in a WinZip file that you can copy to any directory 
on your PC hard drive. Please see Adding a New Database for database installation 
instructions. 
 
The following section describes how to select a database: 

1. You must be in the offline mode in DriveWizard™  
2. From the File Menu select “Change Database” 
3. The window in Figure 3.4 will appear 

 
 

 
 
 
 
 
 
 
 
 
 
 

Figure 3.4: Database Select Window 
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4. Select the database best suited for your application.  If your drive does not appear use the 
standard database unless instructed by a Yaskawa representative to use a specific database. 

5. Click on  OK   to use the selected database and close the window. 
 

 
If the change database menu item does NOT appear under File Menu you 
have only 1 database installed in your DriveWizard™ installation (Typical or 
minimum selection during installation).  If you determine you need a specific 
database that is not standard drive, you must re-install DriveWizard™ using 
the Custom install selection. (see Chapter 2 – Installation) 
 

� 
Note! 

Selecting a Database
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 Going Online

 

Going Online with the Inverter 
 

� 
Note! 

Before starting the online process, please check the following: 
1.  The PC is connected to the drive correctly 
2.  There are no other programs running on the PC that could interfere 
 with the PC serial port. 
3.  The correct database has been selected for the drive you wish to connect. 
4.  The communications settings for DriveWizard™ match the drive settings. 
5.  If you are connecting to a GPD315/V7 or a GPD305/J7, the drive must 
 be stopped in order to go online with the drive. 
 
 

To start the online process, you can perform any one of the following operations: 
 

• Go to the main menu, click on Inverter > Connect 
• Type CTL + C on the PC keyboard 
• Push the  button on the toolbar. 

 
A selection box with a list of all of the drive types that DriveWizard™ can communicate with the 
selected database will pop up (Figure 3.5).  Select the drive you are working with.  The drive 
type may be determined by examining the model number on the front of the drive (Figure 3.6). 

 
 
 
 
 
 

 
 

� 
Note! 

 
G5 =GPD515 
J7 = GPD305/J7 
V7 = GPD315/V7 
 
 

 
 
 
 
 

Figure 3.5: Select Drive Type for Standard Database 
 
Highlight the appropriate drive series and click the Connect  button.  Figure 3.9 should appear 
with a successful connection. If DriveWizard™ can detect the drive type, it will automatically 
make the selection and Figure 3.5 will not appear.
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CIMR-G7 U 20P4 

Going Online

 
      G7: Drive type 

     U: USA standard spec 
     A: Japanese standard spec 
     E: European standard spec 

 
Figure 3.6: Example of Drive Model Number 

 
 
If the communication error window (Figure 3.7) appears instead of the 
manual connection window or it appears after the connection window, please 
check the following:  
1. Check the communication cable between the drive and the PC is the 

correct type and is installed correctly. 
2. The drive is powered up and the settings in the drive match 

DriveWizard™ (especially for RS 422/485 and Ethernet). 
3. The communication parameters in DriveWizard™ are set correctly.  
4. When using Ethernet communications the Ethernet adapter in the PC is 

set up correctly and a connection path from the PC to the drive has been 
established. 

5. When using RS 422 communications check that the wiring from the RS 
422 adapter to the drive is correct  

6. When using RS 485 communications be sure the echo box is checked on 
the communications setup window and the wiring from the RS 485 
adapter to the drive is correct. 

7.  When connecting to GPD315/V7 and GPD305/J7 check that the drive is 
not in the run mode. 

8. When using an USB to serial adapter make sure the adapter is installed 
correctly and the DriveWizard™ communications COM port setting is 
correct. 

 
 

� 
Note! 

 
 

Figure 3.7: Communication Error Window  
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During the going online process DriveWizard™ checks the drive software 
number and size (KVA rating code) to see if it is in the database. If either the 
drive rating or software number do not fit in the selected data base range 
(standard database as default or no database selection), a database error 
window will come up (Fig 3.8 ) and the connection process will be aborted. 
 
 

 
     
 
 
 
 
 

 
Figure 3.8: Communication Error Window 

 
 

 
During the going online process DriveWizard™ uploads the parameters from 
the drive into the PC memory.  If a parameter is not present in the drive or 
the value is out of range, a Modbus error will be generated.  A window will 
pop which will display the parameters that caused the errors (see Figure 3.8). 
The user has the option of saving the information as a text file for future 
reference. 
 

� 
Note! 

� 
Note! 

Going Online

 
 
 
 
 

Figure 3.9: Modbus Communication Error Listing Window 
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 Going Online

 
 
 

  
 

 
 

Navigation Tree 

Monitoring 
Window 

Menus and Toolbars

Figure 3.10: Primary Working Environment (G7 shown) 
 

• The menus and toolbars are used to activate the various functions of DriveW
Chapter 4 for details. 

• The Navigation Tree is used to select the group of drive parameters that ap
Parameter Editor spreadsheet.  Refer to Chapter 5 for details 

• The Status Bar displays status and information of various functions of Driv
to Chapter 5 for details. 

• The Parameter Editor Spreadsheet is used to display and modify drive para
Chapter 5 for details 

• The monitoring window is used to select and display online monitor values
Please refer to Chapter 6 for monitoring and Chapter 7 for graphing functio

• The Run Wizard is used to control the drive for test purposes. Refer to Cha
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Working Offline 
 
You can edit an existing parameter files that have been created previously or create new 
parameter files while in the offline mode.  
 
To Edit a Existing File: 

• Go to the main menu, click on File > Open  
• Click the  button on the toolbar. 

 
An open file selection box with the directory of parameter files will open (Figure 3.11).  If no 
parameter files are stored on the PC, you can use the File > New feature to create a new 
parameter file 

 

 
 

Figure 3.11: Open file Dialog Window 
 

• Select a file to open by highlighting the file name in the window.  Click on the   
Open  button.  Another window will open giving you details of the file you are about 
to load into DriveWizard™ (Figure 3.12).    

• Click on the  Load   button and the file will be loaded. A display similar to Figure 3.9 
will appear without the monitor or graphing tabs. 

 

 

Working Offline 

User entered file comments 
appear in this area 

 
Figure 3.12: Open file Comment Window 
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If the file you are opening was created with a different database than the one 
you have selected, a warning will appear as in Figure 3.13. If you are using a 
standard database you can usually proceed by clicking on  Yes . You should 
check all of the parameters for proper values and do a compare against a 
drive online to insure proper parameter data.  If you are not sure, click  No  
and check which database is selected under File > Change database.   If the 
drive type is not support in the database, the warning in Figure 3.14 will 
appear. 

� 
Note! 

Working Offline 

 
 

 
 

Figure 3.13: Database Version Warning 
 
 

 
 

Figure 3.14: Inverter Not Supported Warning 
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 Working Offline 

To Create a New Parameter File: 
 
1. Go to the main menu, click on File > New. A menu as shown in Figure 3.15 will appear.  

Select the drive family you are working with. Click OK  when you have made your 
selection. 

 
2. A window as shown in Figure 3.16 will appear.  

a. Select the KVA or rating of the drive by making a selection from the drop down 
box.  See the section on inverter initialization for an explanation of the model 
number. 

b. Next enter the drive Software Number.  This number should match the software 
number of the drive that the file is to be used in.  The software number can be 
found in drive monitor U1-14 for GPD515/G5, E7, F7, G7, P7 and U-10 for 
GPD305/J7 & GPD315/V7.  You must enter the proper software number. 

c.  Once these selections are made, click  OK   when finished. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.15: Select Inverter Type Window           Figure 3.16: Inverter Information  
Window (Standard Database Shown) 

 
 
 

 

� 
Note! 

 
Do NOT use the default software number to create a file because with some 
drive families it may cause DriveWizard™  to omit some parameters that you 
may not be aware of. The default number is just a placeholder.
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 Working Offline 

 
3. A warning message (Figure 3.17) will come up indicating that if the designated software 

number that you entered in the software number window is not in the selected database, 
the latest software number in the database will be used as a default. Click on OK   to 
continue. 

 
 
 
 
 
 

Figure 3.17: Inverter Information 
 
 

4. The file Save As window opens up (Figure 3.18). You then name and save the file in the 
appropriate location on your computer. Click on   Save  and a file comments window 
will open (Figure 3.19).  Enter any comments in the window and click   Save  to save 
the file. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 3.18: File Save Dialog Window               Figure 3.19: File Information Dialog Window 
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Chapter 

4 
 
 
 
 

Menus 
 
This chapter describes the menus and list of commands 
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 File Menu

  
File Menu 
 
 
Open File 
 

Toolbar:    
Menu: File > Open File 
Hot Keys: CRTL + O 

  
 
Open File opens a previously saved parameter file or a graph onto the screen.  Clicking on the 

enu item or the  opens a file dialog box (Figure 4.1). m
 

 
 

Figure 4.1: Open File Dialog Window 
 
The user selects a parameter or graph file to open by clicking on the file name.  You can switch 
file directories and disks in the typical Microsoft application manner.  Once the file is selected, 
click Open  to open the file. Click on Cancel  to abort the file open and close the window 
After clicking on Open , a dialog box will open with a description of the file and a prompt to 
ensure this is the correct file to be opened (Figure 4.2). 
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Figure 4.2: Description of a File to be loaded 

 
 Clicking on the Load  button “loads” the data file into the Parameter Editor Spreadsheet. 
 
 

 
If a different file is opened over an unsaved file, all the information from the 
first file will be lost.  
 
Opening a previously saved parameter file allows the parameters to be 
edited without first downloading them from the drive.  This does not 
automatically update the current parameters in the drive if a parameter file 
is being opened.  

� 
Note! 

User entered file comments 
appear in this area 

File Menu
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If the rating or KVA setting of the file being opened does not match the 
online drive (online mode only) a warning window will appear (Figure 4.3). 
It is up to the user to decide if the selected file should be accessed or the open 
file operation canceled. 
 
 

 
 

 
 

Figure 4.3: KVA Mismatch Warning 
 

 
If the file you are opening was created with a different database than the one 
you have selected, a warning will appear as in Figure 4.4. If you are using a 
standard database you can usually proceed by clicking on Yes . You should 
check all of the parameters for proper values and do a compare against a 
drive online to insure proper parameter data.  If you are not sure, click No  
and check which database is selected under File > Change database.   If the 
drive type is not support in the database, the warning in Figure 4.5 will 
appear. 

 
Important ! 

� 
Note! 

File Menu

 
 

 
 

Figure 4.4: Database Version Warning 
 
 

 
 

Figure 4.5: Inverter Not Supported Warning 
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Save Param File 
 

Toolbar:    
Menu: 
Hot Keys: CRTL + S 

File > Save Param File 

 
This function is used to save the parameter working values in the Parameter Editor Spreadsheet 
to an open file on the PC. This selection becomes available when either an existing parameter 
file has been opened, or a connection to a drive has been established.  This automatically saves 
over the previous copy of the file.  If you do not want the previous list erased, choose the Save 
As command.  Saving a file allows the parameters to be edited without first downloading them 
from the drive.  
 

 
1. This does not automatically update the current parameters in the drive. 

The values that are currently in the drive are shown in the inverter value 
column of the Parameter Editor Spreadsheet.  Use the parameter 
download function to update the parameter values in the drive. 

2. If you connect to the drive and click on Save Parm File without opening 
a file, you will be directed to the Save As function (see Save Parm As 
menu item). 

3. When typing in the name of the file, do not use dots to separate the file 
names as DriveWizard™ cannot handle file names with dots.  Example:  
name1.name2.name3.PARMS 

 
 

 

� 
Note! 

File Menu
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 File Menu

 
Save Param File As 

 
 
Toolbar:  None 
Menu: File > Save Param File As 
Hot Keys: CRTL + A 
 

This allows the user to save a new or old file under a different name or format.  Files can be 
saved in a comma separated value (*.csv) and a parameters (*.PARMS) format. When saving 
files, a dialog box will appear and prompt for a file name (Figure 4.6). The csv file format can be 
read in other software programs such as Microsoft Excel (see Figure 4.7). 
 

 
 

Figure 4.6: Prompt to Enter a File Name for Saving 
 
 

G7       
G7: Yaskawa Electric      

22015       
38       

Friday  August 20 2004     
10:27:03 AM       

This is a standard G7 Parameter Table      
Number Name Working Value Units Min Max Default 
A1-00 Select Language 0 -- 0 6 0
A1-01 Access Level 2 -- 0 9999 2
A1-02 Control Method 0 -- 0 4 2
A1-03 Init Parameters 0 -- 0 9999 0

 
Figure 4.7: Sample of CSV File Output in Microsoft Excel 
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� Entering File Comments 

 
After the file name has been entered, there is an opportunity to type in a detailed file description 
(see Figure 4.8). The drive type, company name, software version, date and time are 
automatically stored when saving the file.  
 
You can type in any text you would like to be saved with the file in the space provided in the 
bottom of the window. When finished, click on Save  to save the file. Clicking on Cancel  aborts 
the file saving process and closes the window. 

 

 
 

Figure 4.8: File Comments During Save Param File As 
 

 
1. Note the software version is not shown at this time, but it is stored with 

the file. Both file types (CSV, PARMS) can be imported into MS Excel. 
Values can be adjusted without decimals. However, file cannot be 
reloaded into DriveWizard™ once the data format has been changed.  

2. Saving a file allows the parameters to be edited without first 
downloading them to the drive.  This does not automatically update the 
current parameters in the drive. 

3. When typing in the name of the file, do not use dots to separate the file 
names as DriveWizard™ cannot handle file names with dots.  Example:  
name1.name2.name3.PARMS 

 
 

 

� 
Note! 

File Menu
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 File Menu

 
Close File 

 
Toolbar:  None 
Menu: File > Close File 
Hot Keys: CRTL + E 

 
 
This option is only available when editing a previously saved file while offline with the drive.  It 
closes the current parameter file being edited.  If recent changes have not been saved, 
DriveWizard™ will display a prompt with the option to save the file before closing it (Figure 
4.9).  If the file has been changed and is not saved, the changes will be lost. 
 

 
 

e 4.9: Opportunity to Save a Changed File Before Closing  
 

 
File New 

 

ctory default values and is only available when in the 
offl
drive supported by the selected database current in use 

ee File > Change Database).  To create a new drive 
f-line, please follow the procedure below: 

 
1. Clicking on File > New opens the dialog box 

shown in Figure 4.10.  

pe 
) 

 
 

Figur

Toolbar:  None 
Menu: File > File New 
Hot Keys: None 

 
 
This function creates a new parameter file using 
fa

ine mode. The user can create a new file for any 

(S
file while  of

 
 

       Figure 4.10: Selecting an Inverter Ty
(Standard Database Shown
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2. Select the inverter fam to create the new file.  Only the inverters 

aking your 
ily that you wish 

supported in the selected database will appear in the window.  After m
selection, click on OK  and the dialog box in Figure 4.11 opens.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.  box.  

4. e number of 
the drive that the file is to be used in.  The software number can be found in drive 

r U1-1  for GPD515/G5, E7, F7, G7, & P7 and U-10 for GPD305/J7 &  

Figure 4.11: Selecting Inverter Information  
 

Select the KVA or rating of the drive by making a selection from the drop down
See the section of this manual on Inverter Initialization for an explanation of the model 
number.  
Next enter the drive software number.  This number should match the softwar

monito
GPD315/V7. 
G5 HHP softw
would be ente

4
When the first digit of the software number starts with a 0 (in the case of 
are numbers, use a 5 digit number.  Example: G5HHP software 0211 

red as 10211.  You must enter the proper software number. 
 

o NOT use the default software number to create a file because with some 

 
5. control mode of the drive  (refer to this manual section on inverter initialization 

 
 
D
drive families as it may cause DriveWizard™  to omit some parameters that 
you may not be aware of. The default number is just a place-holder. 
 
 
 

Select the 
for more details).  Click on OK  when finished.  

6. A warning message (Figure 4.12) will come up indicating that if the designated software 
number that you entered in the software number window is not in the selected database, 
the latest software number in the database will be used as a default. Click on OK   to 
continue. 

 

� 
N

File Menu

ote! 
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Figure 4.12: New File Software Warning Window 

 
 

7. The File Save As window comes up and the file is saved as described in File Save As. 
 
 

 
 
When creating a new parameter file, the KVA of the file must match the 
KVA of the drive or an error will occur and the parameters cannot be 
downloaded to the drive (Figure 4.13). 
 
 
 

 

 
  

Figure 4.13: KVA Mismatch Warning 
 

8. Review the saved file for the proper software number; drive model number, and 
parameter set. 

 
 
 
 
If a software number that is below the minimum software number is entered, 
the parameter file will be blank, i.e. no parameters will appear. 
 
 
 

� 
Note! 

 
Important ! 

File Menu
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File Conversion 
 
Toolbar:  None 
Menu: File > File Conversion 
Hot Keys: None 
 

 
This function allows the user to convert parameter files from one standard family type of drive to 
another standard family type.  The conversion is done in the DriveWizard™ off-line mode only. 
This function will read an existing parameter file (input file) and convert or translate the 
applicable parameters to the new file created during the conversion process (output file).  
Parameters in the new file (output file) not found or translated from the existing file (input file) 
will be populated with factory default values of the new file (output file) drive family type.  
 

 
1. The conversion is available only when the standard database is selected. 
2. The conversion does not convert factory or custom parameters. See 

Appendix H for details of the parameter conversion 
3. Some parameters in the input or existing file will not convert to the new 

or output file due to changes in drive family type software.  
4. The conversions are one to one on drive rating or model type.  A 2.2 kW 

480 V drive converts to a 2.2 kW 480 V drive. 
 

 
 
 

� 
Note! 

File Menu
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 File Menu

� G5 (GPD515/G5) to F7 Conversion 
This selection will convert an existing G5 (GPD515/G5) file to a F7 file.  The GPD515/G5 can 
be any standard software number of either 1032 to1043 or 1110 to 1114.  The F7 drive output 
file will be the latest released software number (at this writing 3020). Parameters that are new in 
F7 or not transferable from the GPD515/G5 input file will be present to the F7 factory defaults. 
For a map of the parameter conversion, please see the GPD515/G5 to F7/G7 Conversion Tool 
Parameter Map section in Appendix H. 
 
To use the G5 (GPD515/G5) to F7 conversion tool, please follow the following steps: 

1. Click on File > File Conversion in the top line main menu bar.   
2. Figure 4.14 will appear.  Click on G5 to F7 and then click on OK .  
3. The File Open window (Figure 4.1) will appear.  Select the G5 file you wish to convert by 

clicking on the file to highlight and then click on Open  . If the file that is selected is not a G5 
parameter file, a warning as shown in Figure 4.15 will appear and the conversion will abort. 

 
 
 
 
 
 
 
 

F 
 
 

 
Figure 4.14: Select File Conversion Type  Figure 4.15: Select File Error 

 
4. The conversion process now starts and there is a time delay while the conversion takes place.  

The status bar will read “File Conversion in Progress” during this time.  When the conversion is 
completed, a File Save As window opens (Figure 4.6).  Select PARMS or CSV (if you desire) 
and type in the name of the F7 conversion output file you wish to save. Click on Save   to save 
the file.  A file comment window opens to add file comments if you wish (see Save Parameter 
File As section earlier in this chapter). 

5. A warning window (Figure 4.16) will now appear reminding the user to set the carrier frequency 
and rating of the F7 manually (C6-01, C6-02, etc) . This is because the GPD515/G5 does not have 
the current rating and carrier frequency rules that the F7 has.  Refer to the F7 drive manual 
TM.F7.01 page 5-9 and the F7 drive Programming Manual TM.F7.02 programming page 35 for 
more detail. Click on OK  to complete the file save process. 

 

 
 

Figure 4.16: Carrier Frequency Setting Warning 
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 File Menu

� G5 (GPD515/G5) to G7 Conversion 
This selection will convert an existing G5 (GPD515/G5) file to a G7 file.  The GPD515/G5 can 
be any standard software number of either 1032 to1043 or 1110 to 1114.  The G7 drive output 
file will be the latest released software number (at this writing 22016). Parameters that are new 
in G7 or not transferable from the GPD515/G5 input file will be present to the G7 factory 
defaults.  For a map of the parameter conversion, please see the GPD515/G5 to F7/G7 
Conversion Tool Parameter Map section in Appendix H. 
 
 
To use the G5 (GPD515/G5) to G7 conversion tool, please follow the following steps: 

1. Click on File > File Conversion in the top line main menu bar.   
2. Figure 4.17 will appear.  Click on G5 to G7 and then click on OK .  
3. The File Open window (Figure 4.1) will appear.  Select the G5 file you wish to convert by 

clicking on the file to highlight and then click on Open  . If the file that is selected is not a G5 
parameter file, a warning as shown in Figure 4.18 will appear and the conversion will abort. 

4.  
 
 
 
 
 
 
 

F 
 
 

 
Figure 4.17: Select File Conversion Type  Figure 4.18: Select File Error 

 
5. The conversion process now starts and there is a time delay while the conversion takes place.  

The status bar will read “File Conversion in Progress” during this time.  When the conversion is 
completed, a File Save As window opens (Figure 4.6).  Select PARMS or CSV (if you desire) 
and type in the name of the G7 conversion output file you wish to save. Click on Save   to save 
the file.  A file comment window opens to add file comments if you wish (see Save Parameter 
File As section earlier in this chapter). 

6. A warning window (Figure 4.19) will now appear reminding the user to set the carrier frequency 
and rating of the G7 manually (C6-02, C6-03, etc) . This is because the GPD515/G5 does not 
have the current rating and carrier frequency rules that the G7 has.  Refer to the G7 drive manual 
TM.G7.01 page 6-39 for more detail. Click on OK  to complete the file save process. 

 

 
 

Figure 4.19: Carrier Frequency Setting Warning 
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 File Menu

� P5 (GPD505/P5 or GPD506/P5+) to E7 Conversion 
This selection will convert an existing P5 (GPD506/P5+ or GPD505/P5) file to a E7 file.  The 
P5 file must be a  *.P5 or *.P5P created in InverterWin 3.0.  The E7 drive output file will be 
the latest released software number (at this writing 4010). Parameters that are not transferable 
from the P5 input file will be present to the E7 factory defaults.  For a map of the parameter 
conversion, please see the GPD505/P5 to E7/P7 Conversion Tool Parameter Map or 
GPD506/P5+ to E7/P7 Conversion Tool Parameter Map section under the Appendix H. 
 
To use the P5 (GPD505/P5 or GPD506/P5+) to E7 conversion tool, please follow the following 
steps: 

1. Click on File > File Conversion in the top line main menu bar.   
2. Figure 4.20 will appear.  Click on P5 to E7 and then click on OK .  
3. The File Open window (Figure 4.1) will appear.  Select the P5 file you wish to convert by 

clicking on the file to highlight and then click on Open  . Only P5 and P5P extension files will 
be seen in the open file window. 

 
 
 
 
 
 
 
 

 
 

Figure 4.20: Select File Conversion Type 
 

4. The conversion process now starts and there is a time delay while the conversion takes place.  
The status bar will read “File Conversion in Progress” during this time.  When the conversion is 
completed, a File Save As window opens (Figure 4.6).  Select PARMS or CSV (if you desire) 
and type in the name of the E7 conversion output file you wish to save. Click on Save   to save 
the file.  A file comment window opens to add file comments if you wish (see Save Parameter 
File As section earlier in this chapter). 

5. A warning window (Figure 4.21) will now appear reminding the user to set the carrier frequency 
and rating of the E7 manually (C6-01, C6-02, etc) . This is because the GPD505/506/P5 does not 
have the current rating and carrier frequency rules that the E7 has.  Refer to the E7 drive manual 
TM.E7.02 programming page 29 for more detail. Also, several of the functions in P5 do not 
directly convert to E7 so please check the converted file for the correct drive programming 
(See Appendix H for more detail). Click on OK  to complete the file save process. 

 

 
 

Figure 4.21: Conversion Warning 
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 File Menu

� P5 (GPD505/P5 or GPD506/P5+) to P7 Conversion 
This selection will convert an existing P5 (GPD506/P5+ or GPD505/P5) file to a P7 file.  The 
P5 file must be a  *.P5 or *.P5P created in InverterWin 3.0.  The P7 drive output file will be 
the latest released software number (at this writing 1020). Parameters that are not transferable 
from the P5 input file will be present to the P7 factory defaults. For a map of the parameter 
conversion, please see the GPD505/P5 to E7/P7 Conversion Tool Parameter Map or 
GPD506/P5+ to E7/P7 Conversion Tool Parameter Map section under the Appendix H. 
 
To use the P5 (GPD505/P5 or GPD506/P5+) to P7 conversion tool, please follow the following 
steps: 

1. Click on File > File Conversion in the top line main menu bar.   
2. Figure 4.22 will appear.  Click on P5 to P7 and then click on OK .  
3. The File Open window (Figure 4.1) will appear.  Select the P5 file you wish to convert by 

clicking on the file to highlight and then click on Open  . Only P5 and P5P extension files will 
be seen in the open file window. 

 
 
 
 
 
 
 
 

 
 

Figure 4.22: Select File Conversion Type 
 

4. The conversion process now starts and there is a time delay while the conversion takes place.  
The status bar will read “File Conversion in Progress” during this time.  When the conversion is 
completed, a File Save As window opens (Figure 4.6).  Select PARMS or CSV (if you desire) 
and type in the name of the P7 conversion output file you wish to save. Click on Save   to save 
the file.  A file comment window opens to add file comments if you wish (see Save Parameter 
File As section earlier in this chapter). 

5. A warning window (Figure 4.23) will now appear reminding the user to set the carrier frequency 
and rating of the P7 manually (C6-01, C6-02, etc) . This is because the GPD505/506/P5 does not 
have the current rating and carrier frequency rules that the P7 has.  Refer to the P7 drive manual 
TM.P7.02 programming page 29 for more detail. Also, several of the functions in P5 do not 
directly convert to P7 so please check the converted file for the correct drive programming 
(See appendix H for more detail). Click on OK  to complete the file save process. 

 

 
 

Figure 4.23: Conversion Warning 
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Print Param 

 
Toolbar:   
Menu: File > Print Param 
Hot Keys: None 

 
This function prints out the Parameter Editor Spreadsheet in a “WSYWYG” (What You See is 
What You Get) format.  The parameter group currently displayed in the Parameter Editor 
Spreadsheet is printed on the selected Windows printer. There is no print preview available. The 
output will be formatted identically to the cells in the Parameter Editor Spreadsheet. In other 
words increasing or decreasing the width of a column or the height of a row will affect the 
printout format as well as the display (refer to Chapter 6 for how to change the spreadsheet 
display).  When selecting this function, a printer select and configuration window will pop up 
(Figure 4.24) 
 
 

 
 

Figure 4.24: Print Setup Window 
 
 

 
1. If the printer output is wider than a single sheet of paper, the column 

widths within the parameter editor must be manually reduced or the 
columns that cannot fit onto the first page will be printed on a second 
page. 

2. Another option for printing is to save the parameters to a file and import 
the data into an appropriate program such as MS Excel for printing. 

3. The program will use the default printer and it’s default settings. These 
are changed in the printers folder of Windows. 

 
 

 

� 
Note! 

File Menu
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Print Single Page 

 
Toolbar:  None 
Menu: File > Print Single Page 
Hot Keys: None 

 
 
This function prints a summary of all of the current working drive parameter values available for the 
selected drive in the Parameter Editor Spreadsheet.. This data is condensed onto a single page and 
automatically output to a printer.  Two or more pages may be printed if there are too many parameters to 
fit onto the first page. The format of this print out is fixed and cannot be changed.  The selected Windows 
printer is used for output. 
 
 
Compare Param File  

 
Toolbar:  None 
Menu: File > Compare Param File 
Hot Keys: CTRL + B 
 

 
This function is used to compare two sets of parameter data.  You can compare parameter data 
from the drive connected online to a file or from one file to another.  This command is only 
available once a file has been opened or a connection to the drive has been established.   
 

• To use this function follow these steps: 
1. Connect to a drive online (see Chapter 3) or open a parameter file. 
2. Select: File > Compare Param File from the menu or enter ctrl B on the keyboard. 
3. The sequence of operation for opening a parameter file is then executed. 
4. Once this file is loaded the parameter data in this file is compared to the working values of the 

Parameter Editor Spreadsheet.  When the comparison is complete the window in Figure 4.25 
appears. 

5. The data is presented in a spreadsheet that the display can be changed in the same manner as the 
Parameter Editor Spreadsheet. 

6. To print the differences click on the Print  button on the right hand side of the window.  The 
contents will be printed to the default Windows printer in the same manner as the Print Param 
function.  

7. To save the differences to a *.csv file, click on Save  on the right hand side of the window. A Save 
File As window will open up and you create the name and select the location of the file. 

 
 
You can compare files from only from the same drive family. However, they 
can be different software versions (different flash). 
 
Example:  G5 1032 to G5 1042 but not G5 to F7. 
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• To use the Change Database function, follow these steps: 
 

1. Be sure you have installed DriveWizard™ with a custom install that installs more than 1 database. 
2. Select: File > Change Database from the menu. 
3. The window in Figure 4.26 appears 
 

 
 
 
 
 
 
 
 
 
 
 
 

            Figure 4.26:  Database Select Window 
 
 
4.  You then select the appropriate database for the drive you are working with. If the drive you are 
working with is not listed as a special drive or software, then use the standard database. Select the 
database by clicking on the text line. 
5. If you would like the selected database to be the default every time you start DriveWizard™ , 
click the box next to the text “Always use this database” 
6. Click on OK  to finish the selection and close the window.  

 
DriveWizard™  has the ability to add special databases to the list that is shipped with the 
standard software.  These databases are self-installing that will automatically add the new 
database to the existing list. Please see Adding a New Database in Appendix F to see how to 
install a database to an existing DriveWizard™ installed software program. 
 
Additional databases can be found at/on the following: 

• On the internet at:http://www.yaskawa.com/site/products.nsf/products/Industrial AC 
Drives~DriveWizardTM.html under the download section. 

• CD.AFD7.x,  
• CD.V7J7.x 
• CD.E7.x 
• CD.DW.x 

 
The installation files are contained in a WinZip file that you can copy to any directory on your 
PC hard drive. 
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       Exit  
 
Toolbar:  None 
Menu: File > Exit 
Hot Keys: None 

 
This command closes the program down in the same manner as clicking on the close window 
x on the top right hand corner of the window.   
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Communications Menu 
  
  
Setup 

 
Toolbar:  None 
Menu: Communications > Setup 
Hot Keys: CTRL + P 

  
 
The setup function configures the communications between the PC running DriveWizard™ and 
the drive. There are 2 methods of connecting to the drive:   
 

1. Serial Communications: This method connects DriveWizard™ to the drive through a PC 
COM port. The serial communications can be RS 232C, RS422, or RS485 with baud 
rates of 9600 bps or 19,200 bps. The RS232C can be an existing port on the PC or 
through a USB to serial adapter connected to the PC’s USB port. 

2.  Ethernet: This method connects to the drive with a CMO9x option card through an 
Ethernet network communications adapter on the PC.  

 
A set up window is used to configure the communication method and settings to properly 
connect the PC running DriveWizard™ to the drive (Figure 4.27). If the configuration is not set 
correctly for your situation,  DriveWizard™ will not be able to connect to the drive. 
 

 
 

Figure 4.27: Communication Settings 

Communications Menu
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�

 
Selecting serial comm method selection sets DriveWizard™ to 
connect to the drive through a PC COM port. Listed below are the possible connection types and 
how to set the communication configuration. 

 Serial Communications 

unications in the communication 

 
1. RS232C through PC Port:  This is the most common method (only available method in 

previous versions of DriveWizard™) and is used to connect to the drive via its keypad 
port. Set the Com port selection  to the com port number you have made the physical 
connection from the PC to the drive.  Leave the Slave Address  to 1 unless the slave 
address on the drive has been changed such as the communications adapter for 
GPD305/J7. The baud rate should also remain at 9600 unless it has been changed. 

 
 
The keypad ports of G5, V7, and J7 are fixed at 9600 for  
baud rate selection.  Do not use the 19200 selection if you  

 

 
2. 

s these 
devices

s on the market available 
in electronics stores and over the Internet.  We have tested 2 adapters that are commonly 
available and they function 100% with DriveWizard™: 

(a) Dynex P/N DX-UBD9 available at Best Buy stores 
(b) Radio Shack P/N 26-183 available at Radio Shack Stores 

 
The USB to serial adapter always comes with a CD of the drivers required to 

properly operate the adapter on your particular operating system.  Follow the installation 
instructions provided with the adapter.  It would be a very good idea to go to the 
manufacturer’s website to check for the latest driver’s for your operating system.  

When the adapter is successfully installed, it will appear in the Windows Device 
Manager as another serial port.  Refer to Figure 4.27 for how the Dynex adapter appears. 
The adapter appears under the PORTS (COM & LPT). In Figure 4.28 you can see that it 
is assigned to COM 5.  Therefore, to use this device in DriveWizard™ you would select 
COM 5 on the Communications setting window (Figure 4.27). 

are connected to the keypad port. 
 

 

RS232C through USB Adapter:  This method is becoming more popular as newer PC’s 
do not have a hardware serial port but only USB serial ports.  DriveWizard™ treat

 the same as a PC hardware RS232C port so that DriveWizard™ does not know 
the difference between a USB to serial adapter or a PC hardware port.  The USB to serial 
adapter will be assigned a new PC COM port number (usually above 4) when it is 
installed in the PC. 

There are many manufacturers of USB to serial adapter

 
Important ! 
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USB to  Serial Adapter 

 
Figure 4.28: Windows Device Manager showing USB to Serial Adapter 
 

 
 

 
If you cannot get your USB to serial adapter to work, please check the 
following: 
1. Check the communications window of DriveWizard™ for the proper 

settings (Figure 4.27). 
2. Check that the adapter is installed correctly by checking Windows 

Device Manager (Figure 4.28). 
3. Check that the drivers for the adapter are the latest and the proper ones 

for your Windows operating system. 
4. Check that another program has not captured the USB to serial adapter 

such as Palm Pilot Hot Sync or a DDE server from a data acquisition 
program. 

5. Sometimes re-booting your PC after installing the USB to serial adapter 
will force Windows to enable the device.  

 
 

� 
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3. RS422/RS485: This method is used when there are more than one drive connected to a 

serial network, serial communications is over a long distance, or it is desired to use 
DriveWizard™ while retaining the drive keypad on the drive.  The connection method to 
the drive is through the RS422/485 terminals (or comm. adapter in the case of J7 or SI-
K2 in the case of G5 ). Select the PC COM port that the PC RS422/485 adapter is 
connected to by setting the Com port selection .  Set the Baud rate selection  to the 
network setting and the Slave Address  to match the particular drive you wish to connect 
to.  Factory default setting on the Yaskawa Drives terminal block serial port is 9600 baud 
and slave address 31 (1F hex)..  
 In the case of an RS485 2 wire network connection, the RS 485 Echo box may 
have to be checked so DriveWizard  will function correctly. In a 2 wire set up the 
transmit and receive lines are jumped together (T+ to R+, T- to R-) so that the transmitted 
message from DriveWizard  appears on the receive lines as well as the actual message 
from the drive.  Checking the RS 485 Echo box allows DriveWizard  to ignore its 
transmitted message and only look at the actual message from the drive. The RS 485 
adapter that you are using may have an echo cancellation feature also that prevents the 
transmitted message from appearing on the receive message signal in the PC.  If the echo 
cancellation is selected on the converter, you should not check the RS 485 Echo box in 
DriveWizard   
 

 
1. While utilizing the 2 wire RS 485 communications set up and using 

RunWizard to run the drive; a communications fault may occasionally occur 
due to timing with some drives. 

2. While utilizing the 2 wire RS 485 communications set up while going online to 
the drive with a slow PC may cause a CE error on the drive.  The may occur 
if the online process time exceeds the CE timeout setting in the drive. 

 
If you cannot establish communication with the drive, check the following: 
1. Be sure the settings in Figure 4.27 above are correct. 
2. Check that no other applications are running which requires the com port 

selected (such as Hot Sync Manager for Palm Pilot). 
3. Check the communication cable for proper connection. 
4. Check the drive communications settings.  If possible initialize the drive 

through its keypad to restore the proper communications settings. 
5. Check that the drive software is the correct version and/or is supported by 

the database you have selected.  Connecting to a drive in which the drive’s 
software is not listed will give an error. 

6. Check that the address of the drive and the communications window match. 
7. Check that in the case of RS 422/485 that the converter settings are correct 

and the converter has power or good batteries (if not self-powered. 
8. For GPD315/V7 and GPD305/J7 check that the drive is stopped (not 

running). 
 

 

� 
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� Ethernet Communications: 

 Selecting this option sets DriveWizard™ to connect to the drive through an Ethernet 
network to an CMO9x option card mounted on the drive.  For DriveWizard™, the only settings 
required are the IP address of the drive you are connecting to and whether or not you are just 
monitoring or utilizing RunWizard.  DriveWizard™ has the factory default setting of 
192.168.1.20 in the Drive Name, Drive Address  setting window so that if the card has not yet 
been configured you can use this default address.  

When using the GPD315/V7 CMO91 or CMO93 communications kits you will need to 
select the proper database (V7 Ethernet) that supports the GPD315/V7 with these 
communications kits.  Also, the GPD315/V7 drive must have the proper software installed for 
the CMO91 or CM093 communication kit to work properly.  Refer to the CM091 or CMO93  
installation guide for further information. 
 

 
 

Figure 4.29: Ethernet Communication Settings 
 
Control Selection  

.29) selects whether or not RunWizard is utilized.  Selecting The control selection  (Figure 4
Monitor Only  mode sets Ethernet connection to a monitor type that can be disconnected with no 
faults, etc. but RunWizard and Reset Fault are disabled. Selecting Run Wizard Allowed  mode 
sets the Ethernet connection to a control type that allows RunWizard to function and is 
constantly monitored by the CMO9x card. If communication is lost for more than 2 seconds th
CMO9x will declare an EF0 fault to the drive. The drive will alarm or fault dep

e 
ending on 

parameter settings. The Reset Fault function is also available to reset drive faults that can be 
reset remotely. 
 
Drive Name, Drive Address  
The Drive Name, Drive Address  box (Figure 4.29) has the ability to allow the user to store 
multiple IP or drive addresses and assign a drive name to that address. The list is stored in the 
DriveWizard™ directory as a CSV file such that it can be edited in Excel or in DriveWizard™ 
(the list can be as long as you wish).  The name should be limited to 32 characters to properly 
display the name on the status bar (see STATUS BAR in Chapter 5, Monitor). 

Communications Menu
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To add a new drive name and address simply type in the new name and address in the 
window and click on the Add Drive button. Be sure to separate the name and address by a colon 
“ : “.  To select a new drive address, click on the down arrow on the right of the box and a list of 
all of the drive addresses entered into DriveWizard™ will appear and click on the desired address 
to select it.   

The Delete Drive  button removes the current drive from the list.  A warning window will 
appear to check if you really wish to delete the drive from the list (Figure 4.30).  

 
 
  
 
 
 
 
 

Figure 4.30: Delete Drive from List Warning 
 
 
The  Clear All Drives  button clears the entire list of drive names and IP addresses.  A 

warning window comes up to warn you if you wish to continue (Figure 4.31). 
 
 
 
 
 
 
 
 

Figure 4.31: Delete All Drives from List Warning 
 

As mentioned before, the list can be edited from Excel or other application that 
can edit a *.csv file.  Figure 4.32 shows the IP address list being edited in Microsoft 
Excel. Be sure when you save the file that you keep the same name and that it is located 
in the main DriveWizard™ program file directory and is named IPList.csv.  The file can 
be edited, but the file name MUST remain as IPList.csv . 
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Figure 4.32: IP address list in Windows Excel 
 
 
 

 
1. When using a CMO91 or CM93 Ethernet for GPD315/V7 kit you must 

have the proper database selected which is V7_CMO9x or V7 Ethernet 
(VSP018340 and VAP018350). 

2. The proper software must be loaded into the GPD315/V7 for the CM091 
or CMO93 communication option card to work properly.  Refer to the 
CM091 or CMO93  installation guide for further information. 

 
 

 
 

� 
Note! 
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  It is very important that the network configuration and the Ethernet adapter in the PC are 
set correctly to allow DriveWizard™ messages to reach the drive correctly.  A good check of this 
is launching Internet Explorer on your PC and type in the IP address (Example: 
http://198.162.1.20, the factory default IP address) of the drive you wish to connect with 
DriveWizard™.  The drive web page should come up on PC display.  If is does not, then the 
respective PC Ethernet adapter settings and network configuration should be investigated for 
proper settings.  If the web page appears DriveWizard™ should have no problem connecting to 
the drive. 
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 To test the PC to drive Ethernet connection and verify the CMO9x card is operating 
properly, a direct connection method can be utilized to check operation.  Below are two 
examples of connecting the PC directly to the drive equipped with a CMO9x card (Figures 4.33a 
and 4.33b): 
 

 
Figure 4.33a: Direct Ethernet connection of PC to drive via cross-over cable. 
 
 

 
Figure 4.33b: Direct Ethernet connection of PC to drive via hub. 
 
 
The dir  made by either Figure 4.33a with a cross – 
over cable 
 
To make a 

1.  Physic in Figure 4.32. 
2.  Co  

the foll
a. on Start>Settings>Control Panel>Network or Dial up 

on 

c. , 

e. w 
 window labeled ”subnet mask 

ect connection from the PC to the drive can be
or Figure 4.33b with standard cables and an Ethernet hub. 

direct Ethernet connection from the PC to the drive, please follow this procedure: 
ally connect the drive to the PC by either of the two methods show 

nfigure the PC’s Ethernet adapter IP protocol settings to match the CMO9x card by
owing (if you are permitted to do so): 
On you PC click 
Connections. 

b. Select the Ethernet adapter you have connected the Ethernet cable to and click 
that connection to open it’s configuration dialog box (Fig. 4.34a). 
In the window titled “ components checked that are used by this connection”
scroll down to the item labeled” Internet Protocol (TCP/IP)” and click on that 
item to select it. 

d. Click on the properties button and the window in Figure 4.34b will appear. 
Select the item ”use the following IP address:” and fill in the address windo
with 192.168.1.1 as shown in Figure 4.34c.  The
will fill in automatically with the numbers as shown when the IP address is 
entered.  Leave the “Default gateway”, “Preferred DNS server”, and “Alternate 
DNS server” windows blank. 
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f. ill 
 You may have to re-start your 

g. 

s, set the CMO9x card back to it’s factory defaults using the 
procedure outlined in the CMO9x installation guide. If you cannot connect to the 
drive, recheck all of your settings in your PC, your cable connections, and the 
CMO9x for proper operation and settings. 

h. Once a proper connection to the drive is establish through Internet Explorer, 
DriveWizard™ should have no difficulty in connecting to the drive. The drive’s IP 
address will appear in the right hand side of the status bar  (see Chapter 5 Main 
Display: Status Bar) 

 
 

Click on OK to enter the information. After the window closes, Figure 4.34b w
appear. Click on OK to close this window. 
computer to have your new settings take affect. 
Launch Internet Explorer on your PC.  After the program is finished loading, type 
in the proper IP address and check that you can connect to the drive. If there is 
doubt to the IP addres

        
 
Figure 4.34a: Ethernet Adapter Properties         Figure 4.34b: Selecting Internet Protocol 
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Figure 4.34c: TCP/IP Properties 
 
 

 
1. Any questions, problems, or issues concerning the Ethernet adapter and 

the connection to the CMO9x drive option  should be referred the 
appropriate user’s IT, Network Administrator, or computer maintenance 
personnel  responsible for the PC you have DriveWizard™ loaded on. 

 
2. Remember to return your PC’s Ethernet adapter back to it’s prior 

settings after completing this test! 
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Inverter Menu 
 
 
Connect 

 
Toolbar:   
Menu: Inverter > Connect 
Hot Keys: CTRL + C 
 

 
The Connect function establishes communication between the PC and the drive. This function is 
available only if you are offline.  When executing this function a selection box with a list of all 
of the drive types that DriveWizard™ can communicate with may pop up if 
DriveWizard™ cannot detect the drive type automatically.  Select the drive you are working 
with.  The drive type may be determined by examining the model number on the front of the 
drive (See Figure 4.47). 

 
 
The GPD315/V7 and GPD305/J7 drives must be stopped (not in the run 
mode) in order for DriveWizard™  to connect to these drives. 

  
 
 

 
The process continues as described in Chapter 3 – Going Online with the Drive.  If there is data 
in the working column of the Parameter Editor Spreadsheet that is different from the drive or 
iles, it will prompt the user to save this working data (Figure 4.35).  f

 
 
 
If the Working Value data is not saved, DriveWizard™  will erase it when 
uploading the current parameters from the drive into the Parameter Editor 
Spreadsheet. 

 
 

� 
Note! 
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Figure 4.35: Prompt to Save Working Data 
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Disconnect 
 
Toolbar:   
Menu: Inverter > Disconnect 
Hot Keys: CTRL + D 
 

 
The disconnect function stops the communication between the PC and the drive. This option is 
not available if communication has not been established.  When disconnecting, if the parameter 
data in the working column of the Parameter Editor Spreadsheet differs from the drive data, 
DriveWizard™ will prompt the user to save the data in the Parameter Editor Spreadsheet to a file 
(Figure 4.35). 
 

 
 
If you select no on the save working data window, the changed data in the 
Parameter Editor Spreadsheet working values will be lost. 
 
 
 

� 
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Read All 

 
Toolbar:   
Menu: Inverter > Read All 
Hot Keys: CTRL + U 

 
 
 
The Read All function reads all the allowable parameters from the drive into the “Inverter” and 
“Working Value” columns of the Parameter Editor when online.  When activating this function 
the window in Figure 4.36 appears. 

 

 
 

Figure 4.36: Prompt for Overwriting Working Value Column 
 

This warning is to let the user know that the drive parameter data in the Working Value column 
will be overwritten.  Clicking on OK  continues the operation.  If you click on Cancel , no action 
will be taken and the window will close. 
 
 
 

 
 
If a Modbus error occurs during reading or writing parameter(s) to the 
drive, this error means that there is a parameter mismatch between the 
drive and DriveWizard™ .  A window will appear displaying the parameters 
that have errors (see Figure 3.9).   Check that the database you have selected 
upports the drive software.   s

 
 

 
Important ! 
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 Inverter Menu 

 
Read Single Param 

 
Toolbar:   
Menu: Inverter > Read Single Param 
Hot Keys: CTRL + SHIFT + U 

 
 
The function Read Single Parm reads a selected parameter from the drive into the ”Inverter” and 
“Working Value” columns of the Parameter Editor Spreadsheet (Fig 4.37).   This function will 
upload the parameter on the row that a cell is currently highlighted (see Chapter 5). When the 
function is started, Figure 4.36 will appear to remind the user that the data for the selected 
parameter in the Parameter Editor Spreadsheet will be overwritten by this operation.  Clicking on 
OK  continues the operation. If you click on Cancel , no action will be taken and the window will 
close. 
 
 
 
 
 

 
 

Figure 4.37: Selecting Parameter to be Read 
 

 
 
If a Modbus error occurs during reading or writing parameter(s) to the 
drive, this error means that there is a parameter mismatch between the 
drive and DriveWizard™ .  A window will appear displaying the parameters 
that have errors (see Figure 3.9).  Check that the database you have selected 
supports the drive software.   
 

 
Important ! 
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Write All 

 
Toolbar:   
Menu: Inverter > Write All 
Hot Keys: CTRL + SHIFT + D 

 
The function Write All writes all the parameters in the “Working Value” column of the 
parameter editor to the drive.  The “Inverter Value” column of the parameter editor will be 
updated upon completion (Figure 4.38). 
 
 
 
 

 
 

Figure 4.38: Parameter Editor Spreadsheet  
 
 
When the write all function is sta
they would like to skip the KVA
process (Figure 4.39). 
 

The purpose of these options is to allow the user to download a 
parame is in a different 
con l

• e, 
ng of the drive is 

called a KVA dependent parameter.   
• A parameter that changes it’s default, range, scaling, or 

led a 
control mode dependent parameter.  

ese options. 

The user can select either or both of these options by clicking on the appropriate box to the left 

rted, a download options window will appear asking the user if 
 dependents or control mode dependents during the download 

ter file to a drive of a different size or 
tro  mode.   

A parameter that is related or changes its default, rang
scaling or is applicable due to the rati

is applicable to only certain control modes is cal

Inverter Column Working Column 

Inverter Menu 

Figure 4.39: Download Options 
 
Refer to Appendix J for a list of parameters that are affected by selecting th
 

of the selection.  Click on OK  to proceed.  The user can skip this feature and download all 
parameters by leaving the selection boxes blank and just clicking on OK .
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 Inverter Menu 

When this function is started, a window will appear warning the user that all of the drive 
parameters will be overwritten with the data in the Working Value column of the Parameter 
Editor Spreadsheet (Figure 4.40). 
 

 
 

Figure 4.40: Parameter Download Warning 
 

Selecting Yes  will proceed with the download.  No  will cancel the operation and close the 
window.  

 
 

 
Important ! 

If a Modbus error occurs during reading or writing parameter(s) to the 
drive, this error means that there is a parameter mismatch between the 
drive and DriveWizard™ . A window will appear displaying the parameters 
that have errors (see Figure 3.9).  Check that the database you have selected 
supports the drive software.   
 
 

 
 
 

 

� 
Note! 

The download process may take over 30 seconds at times to complete 
depending on the number of parameters to download. 
 
Only the non-shaded or active parameters will be downloaded.  The shaded 
parameters will be ignored (see Fig 4.41) (See Chapter 5).   
 
 

 

 
 

Figure 4.41: Shaded vs. Non-Shaded Cells 
 
 
 
This feature is locked out when the Write Disable function is turned on.  

Important ! 

Non-shaded cells 

Shaded cells 
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Write Single Param 

 
Toolbar:   
Menu: Inverter > Write Single Param 
Hot Keys: CTRL + O 

 
The function Write Single Parm writes only the selected parameter in the “Working Value” 
column of the Parameter Editor Spreadsheet to the drive. This function will download the 
parameter on the row that a cell is currently highlighted. The value in the “Inverter” column of 
the parameter editor for that parameter will be updated upon completion. 

  
Values in a shaded cell may not be written with this command 
 
The Read All, Read Single Parm, Write All, and Write Single Parm selections 
are only available after communication with the drive has been established.  
 
The following parameter groups are the only parameters  written together 
during a single parameter write command: 
1. Accel/Decel units and related parameters: 

G5, E7, F7, G7, P7:C1-01 ~ C1-10 
V7: n018 ~ n022 (and n041 ~ n044 for version 24+) 

2. Frequency display units and related parameters: 
 G5, E7, F7, G7, P7: d1-01 ~ d1-09 and o1-03. 
 V7: n024 ~ n032, n035, and n120 ~ n127. 
3. Vf Pattern: G5, E7, F7, G7, P7:E1-03 ~ E1-13 
 
The above parameters will have red bullets when the master parameter is 
changed. See Display Attributes. 
 

 
 
 
 
This feature is locked out when you have the Write Disable function turned on. 
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Factory Password 

 
Toolbar:  None 
Menu: Inverter > Factory Password 
Hot Keys: None 

 
 
Factory parameters are parameters that are to be adjusted by qualified technicians trained on the 
drive factory parameter set.  These parameters can have severe effects on system performance, 
and therefore may be adjusted by factory representatives only. 
 
 
 
Write Disable Password 

 
Toolbar:  None 
Menu: Inverter > Write Protect Password 
Hot Keys: None 

 
The write disable password allows the user to prevent DriveWizard™ from writing any 
parameters, initializing the drive, or using RunWizard.  In other words, the PC tool can only read 
parameters and monitor data.  
 
The write disable has two modes:  

1. Prevent writing to the drive during the current on-line session only   
2. Prevent writing to the drive at any on-line session.  

 
When the write disable mode is turned on in DriveWizard™ there is a indicator in the status bar 
to show that write disable is on (Figure 4.42).  The download functions on the toolbar and under 
the Inverter menu will be grayed out. 
 
 
 

 
 

Figure 4.42: Status Bar with Write Protect enabled 
 

 
The following functions are disabled when the write disable is active: 
1. Write All Parameters 
2. Write Single Parameter 
3. Inverter Initialize 
4. Autotune 
5. RunWizard 

 

� 
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To enable write disable, select Inverter > Write Disable Password from the menu bar.  This can 
be done either off-line or on-line. The write password window comes up with all of the functions 
displayed that indicates that there is no password set (Figure 4.43).   
 

 
 

Figure 4.43: Write Password Set Window with no Password Set 
 

To activate the write disable enter a password in the entry box (Figure 4.44).  The password can 
be characters or numbers.  Once the password is set it remains set until DriveWizard™ is re-
installed.  There are two boxes that you can check: 
 

Write disable:   
This mode disables writing to the drive while on-line with the drive for the current on-
line session only. When DriveWizard™ is closed out or shut down, the write disable goes 
off so the next time the DriveWizard™ is opened or started, there will be no write disable.  
 
Write disable on start:  
This mode disables writing to the drive all of the time until the password is entered. and 
this box is unchecked.  When this box is checked, DriveWizard™ automatically checks 
the Write disable box when DriveWizard™ is opened.  

 

 
 

Figure 4.44: Write Password Set Window with Password entered 
 

When both boxes are checked writing to the drive is disabled during the current on-line session 
and every time DriveWizard™ is used until the correct password is entered and the boxes are 
unchecked.  Once the password is entered and the appropriate selection boxes are checked, click 
on OK  to accept the entries and close the window.  Clicking on Cancel stops the write 
password process and closes the window.

Inverter Menu 

71 



 Inverter Menu 

 
To change the function of write disable, you click on Inverter> Write Disable Password and you 
have to enter the correct password to change the function. This can be done either on-line or off-
line.  The Window is grayed out until the correct password is given (Figure 4.45).  Once the 
correct password is entered, make the changes required and click on OK  to change the function 
and close the window.  If the password is lost, re-installing DriveWizard™ will reset the function 
to off and reset the password to not used.  
 

 
 

Figure 4.45: Write Password Set Window with Password set 
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Initialize Inverter 
 
Toolbar:  None 
Menu: Inverter >Initialize Inverter 
Hot Keys: None 

 
This function resets the drive to its factory default parameter values.  There are 4 settings that 
affect which default values are used.  When the Initialize Inverter is selected Figure 4.46 will 
appear 
  

 
 

Figure 4.46:  Initialize Inverter Screen 
 

Three of the four properties may be changed to ensure correct initialization.  The KVA property 
is read only.  Once the selections have been chosen, click Initialize to complete the process.  
Clicking on cancel stops the operation and closes the window.  When Initialize is chosen, the 
window in Figure 4.47 appears. 
 

 
1. When the drive is initialized, all of the drive parameters are reset to their 

original factory settings.  This could cause machine safety issues if the 
drive is not set programmed correctly.   

2. You should save all of the drive parameters before performing an 
inverter initialization. 

3. The drive initialization function is locked out when you have the Write 
Disable function turned on.

 
Important ! 

Inverter Menu 
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Figure 4.47:  Initialize Warning Screen 
 
Clicking on Yes  will continue the operation.  Clicking on No  will return you to the Initialize 
Inverter Window. 
 
 

 

� 
Note! 

 
 
All drive parameters are initialized to factory default settings at time of 
shipment. 
 
 

 
 
� Initialize Properties Description: 

 
•         The KVA represents drive size and includes voltage. This is a read only 
sele
sett
 
 

 

Inverter Menu 

 
                 KVA Selection
ction.  DriveWizard™ automatically detects which drive is present.  You should verify the 
ing found on the external part of the drive as part of the model number (Figure 4.48).  

CIMR-G5 U 20P4 
           

G5: correct type       0P4: 0.4 kVA 
Ex: J7, V7       Ex: 075: 75 kVA 

     U: USA standard spec 
     A: Japanese standard spec 
     E: European standard spec 
 
Figure 4.48: Example of Model Number 
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•   The control mode parameter sets the basic control strategy of the drive.  
Th
of 
 
Co

 
• 
cou
 
•  
typ
det
on 
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C
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V/f
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V/f
Co
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Op
Lo
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Ve

Inverter Menu 

 

  Control Method

e selections available for the connected drive vary by drive family.  See Table 4.49 for a few 
the features associated with each control method.   

ntrol Modes: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Table 4.49: Selected Features of the Control Methods 
 

 
 
Not all of the Yaskawa drives allow the setting of control mode during 
initialization.  Some drives only have one control mode.  DriveWizard™ will 
make this property available when it can be changed for initialization. 
 
 
 

This refers to the specification that the drive was manufactured under in the 

e
e
a
f

ontrol 
ethod 

Drive 
Types 

Basic 
Control 

Speed 
Detector 

Torque 
Limit 

Torque 
Control 

Applications 

 
ntrol 

G5, E7, F7 
G7, J7, P7, 
V7 

Voltage/Freq- 
uency  Control 

Not 
Needed 

Not 
Possible 

Not 
Possible 

-Multiple motor 
drives  
-Basic adjustable 
speed application 

 
ntrol 
h PG 
dback 

G5, F7, G7 Voltage/Frequ
ency Control 
with Speed 
Compensation 

Needed 
(Pulse 
Generator) 

Not 
Possible 

Not 
Possible 

-Application 
where pulse 
generator is 
applied to 
machine side 

en 
op 
ctor 

G5, F7,  
G7 (2 
modes), 
V7 

Sensorless 
vector control 

Not 
Needed 

Possible Not 
Possible 
(Possible 
G7 mode 
2) 

All range of 
variable speed 
applications 

x 
ctor 

G5, F7, G7 Current Vector 
Control 

Needed 
(Pulse 
Generator) 

 Possible Possible -Simplified servo 
drives 
-High-accuracy 
speed control 
-Torque Control 

� 
Note! 
 Spec

ntry that it was produced.  This should be set according to the nameplate specifications. 

 This refers to the type of factory initialization that will occur. There are three 
s of initializations: 2-wire, 3-wire, and user.  A 2-wire and 3-wire initialization will 
rmine how the drive is run and stopped through the digital input terminals. This is available 
ll Yaskawa Drives.  User initialization is available only on the G5, E7, F7, G7 and P7 drives. 

er to the product manual of the respective drive for more details on 2-wire and 3-wire control. 

Type 
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 Inverter Menu 

 
Auto-tune 

 
Toolbar:  None 
Menu: Inverter >Auto Tune 
Hot Keys: None 

  
 
This menu item allows the use of the Auto Tuning features of the E7, F7, G7, and P7 drives.  
You must be on line to utilize this function.  To activate this function, click on Inverter > Auto-
tune.  The checklist window (Figure 4.50) will appear reminding the user to make sure all safety 
precautions are taken. 
 

 
 

Figure 4.50: Auto-tune Check Point Window 
 
 

Clicking on Yes  will continue the process, No  will cancel the auto-tune function. When 
clicking on Yes , the main auto-tune window will appear (Figure 4.51).   
 
The auto-tune function features 3 types of motor tuning that are available on Yaskawa E7, F7, 
G7 and P7 drives. They are: 

1. Line to line resistance:  
This tuning calculates the motor terminal resistance value.  The motor does not turn 
during this function. 

2. Auto-tuning without motor rotation: 
This tuning function calculates most of the motor parameters without turning the motor 
shaft. It is available only on F7 and G7 in the Open Loop Vector and Closed Loop 
Vector control modes. 

3. Auto-tuning with motor rotation: 
This tuning function calculates all of the motor parameters with turning the motor shaft. 
It is available only on F7 and G7 in the Open Loop Vector and Closed Loop Vector 
control modes. The motor mechanical load must be disconnected to allow the tuning 
function to operate correctly. 
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Figure 4.51: Auto-tune Main Window 
 

To perform an auto-tune, follow these steps: 
1. Select Motor #1 or #2 by  clicking on the appropriate button in the T1-00 box 
2. Select which tuning method you would like to perform.  The method(s) available for the 

particular drive and control mode will appear normally (not grayed out). 
3. Enter the data in the windows that appear for other T1 parameters. The number of T1 

parameters that appear is based on the drive type and control mode it is in. 
4. Click on the Load button to download the entered T1 parameters to the drive. 
5. When downloading is complete the start button will become active. 
6. Click on the Start  button to start the auto-tune. An auto-tune run warning window will 

appear (Figure 4.52).  Click on OK  to continue the auto-tune.  
7. The status and progress of the auto-tune will be displayed in the upper right-hand side of 

the window. You can stop the auto-tune at any time by clicking on the Stop  pushbutton. 
While the auto-tune is running the drive output current and frequency will be displayed 
(see Figure 4.53). A flashing green light indicates the auto-tune is in progress and 
DriveWizard™ is communicating with the drive. 

8. When the auto-tune is complete DriveWizard™ will read the appropriate Ex-xx 
parameters from the drive and display them in the after column of the Motor Parameter 
spreadsheet. 

9. You can exit the auto-tune function by clicking on Cancel  or closing the window. 
10. You can start another auto-tune by clicking on the Load  button.  Be sure to make any 

changes before clicking on Load . 

Inverter Menu 
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Figure 4.52: Auto-tune Run Warning Window 
 
 

 
 

Figure 4.53: Auto-tune Progress Display 
 

� Auto-tune Properties Description: 
 

These are the T1 tuning parameters of the drive.  Refer to the 
appropriate drive manual for details of these parameters.  The user 

 

 

Inverter Menu 
T1-00 :T1-09
 selects/enters the data for auto-tuning the drive and are downloaded to 
the drive when the Load  button is clicked. 
 
This window shows the current status of the auto-tune process.  Any Auto-tune Status 

errors during the auto-tune are displayed in this window. 

This is a bar graph that shows the progress of the auto-tune while 
running. 
 
This button, when clicked, will cause the appropriate T1 parameters to 
be downloaded to the drive.  The button becomes active whenever the 
auto-tune main window opens or when a T1 parameter is changed after 
the load is clicked. The button is inoperative during auto-tune run. 

Auto-tune progress 

Load 
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This button starts the auto-tune process.  It is active only after a load has 
been completed. Once clicked, the button will not be active until another 
load has been completed. 
 
This button stops the auto-tune process.   It is only active while the auto-
tune is running. Once the auto-tune is stopped, you must reload the T1 
parameters by clicking on the Load  before you can start again. 
 
This button cancels the auto-tune process and closes the auto-tune 
window.  If clicked during auto-tune run, the auto-tune will stop and the 
auto-tune window will close.  

 
This spreadsheet shows the appropriate Ex-xx motor parameters in the 
drive.  The   Before     column data shows the value of the parameters 
when the load button is pushed.  The  After  column data shows the 
value of the parameters after the completed auto-tune. They are read 
right after the drive has finished the auto-tune process. 
 

 
 
 
The Auto-tune feature is locked out when the Write Disable function is 
turned on. 

 
Important ! 

Stop 

Cancel 

Motor Parameters 

Start 

Inverter Menu 
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Reset Fault 

 
Toolbar:  None 
Menu: Inverter >Reset Fault 
Hot Keys: None 

  
 
This menu item allows the user  the ability to reset a drive fault through DriveWizard™ when in 
the on-line or connected mode.  DriveWizard™ will reset any drive fault that can be reset 
through the operator keypad reset button command.  Be aware that some faults cannot be reset 
by the reset process, but only by cycling the drive main power.  Please refer to the 
troubleshooting  section of the respective manual for your particular drive for more details. 
  
To use this function, click on menu item  Inverter>Reset Fault.  If a drive fault is detected the 
menu item will be enabled (see the status bar for indication that a drive fault has occurred).  If no 
faults are present, the menu selection will be grayed out. A warning window (Figure 4.54) will 
appear to confirm that you wish to reset the fault.  Click on  OK  to reset the fault or Cancel  to 
not reset the fault. 
 

 
 

Figure 4.54: Reset warning window. 
 

 
 is the responsibility of the user of DriveWizard™ to use this function 
roperly.  Resetting the same faults repeatedly can cause drive damage or 
ilure.  Also, think about the safety of those around the machine by 

hecking that personnel are clear of the machine before resetting a fault and 

 
 

 
1. When using Ethernet Communications you must use the Run Wizard 

allowed mode to use the Reset Fault function.  When you are in the 
Monitor only mode the Reset Fault function is not active. 

2. This feature is locked out when the Write Disable function is turned on.

� 
It
p
fa
c
starting the machine. 

 

Note! 

 
Important ! 

Inverter Menu 
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Monitor Menu  
 
 
Start 

 
Toolbar:   
Menu: Monitor > Start 
Hot Keys: CTRL + G 

  
This function will start the online monitoring operation. A connection must be established before 
this function is available. When the function is started, DriveWizard™ will actively monitor the 
parameters the user has chosen to observe. A blinking heart will appear in the lower right hand 
side of the status bar indicating the monitor function is active (see Chapter 5, status bar). The 
monitor values are updated every 500 milliseconds.   Monitor parameters may be visible before 
Start is pressed, but the values of the drive activity are not up-to-date.  
See Chapter 6: Monitoring for more details. 
 

 
 
You must be online with the drive for this function to work and have at least 
one monitor item checked on the monitor setup screen (see Chapter 6, setting 
up the monitor). 
 
 

� 
Note! 

Monitor Menu

 
 
 
 
 
Stop 

 
Toolbar:   
Menu: Monitor > Stop 
Hot Keys: CTRL + SHIFT +S 

 
 
The Stop function is only available while DriveWizard™ is actively monitoring the drive.  
Selecting Stop from the Monitoring menu will stop DriveWizard™ monitoring drive activity.  
See Chapter 6: Monitoring for more details. 
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Help Menu   
  
  
About 
 

Toolbar:  None 
Menu: Help > About 
Hot Keys: None 

 
 
Displays the version of DriveWizard™ installed. 
 

 
 

Figure 4.55: About Window 

 

 
Will attempt to automatically connect to the drive website of YASKAWA ELECTRIC AMERICA if 
internet service is available. This website is: 
http://www.yaskawa.com/site/products.nsf/home/home.html

 
 
Web Site 

Toolbar:  None 
Menu: Help > Web Site 
Hot Keys: None 
 

   
 
Some of the many information items available on the site are: 

• Updates and other information on DriveWizard™ 
• Drive Product brochures and manuals 
• Drive Application notes 

 

Help Menu
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DriveWizard Help 

 
Toolbar:  None 
Menu: Help > DriveWizard Help 
Hot Keys: None 

 
 
Activating this menu item will launch the DriveWizard™ Help application. This application functions like 
Microsoft style help that Windows users are familiar with.  Most of the contents of this manual are 
incorporated in the DriveWizard™  help. 
 

 
The DriveWizard™ Help application requires that you must have Internet 
Explorer 4.01 or greater installed along with the Microsoft HTML help 
viewer files. If you have Windows 98, 2000, XP, or NT SP4 the help viewer is 
part of your O/S installation.  Windows 95 and ME users may have to install 
the help viewer files by executing the hhupd.exe .  This self-extracting file is 
available on Yaskawa CD’s, on yaskawa.com, or on the Microsoft Web site. 
 

� 
Note! 

Help Menu

 
 
 
 

83 



 

Chapter 

5 
 
 
 
 

Main Display 
 
This chapter describes the functions and features of the main display page 
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Introduction 
 
 
The main display chapter of this manual covers three areas of the main display page: 

• The Navigation Tree 
• Status Bar 
• Parameter Editor Spreadsheet 
 

Figure 5.1 below outlines the items covered in this chapter. 
 

t

Introduction

 

 
 
 

Parameter Editor Spreadshee
 
 

Figu
 
 Status Bar
Navigation Tree
 
re 5.1: Main Display 
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 Navigation Tree 

 

Navigation Tree 
 
 
The navigation tree allows the user to quickly switch between the parameter groups displayed in 
the Parameter Editor Spreadsheet and gives the user a visual reference of the drives set of 
parameters.  Simply left-click on a group in the Navigation tree and that group’s parameters will 
be displayed in the Parameter Editor Spreadsheet. (Figure 5.2 a,b,& c).  
 

       
 
Figure 5.2a: G7 Navigation Tree           Figure 5.2b: V7 Navigation Tree 

  (G5, E7, F7, P7 Navigation Tree Similar)           
 
 

 

 
 
Figure 5.2c: J7 Navigation Tree 
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Status Bar  
  

  
The status bar is located at the bottom of the main display and is used to provide the user with 
information and status on the drive, the drive/PC connection, and the PC DriveWizard™ 
software. The bar is divided into 3 main sections (Figure 5.3a):   

1.  Status Message   
2.  Drive information   
3.  Status icons 

 Inverter Information Status Icons

Status Bar

 
 
 
 

 
Status

 
This sect
Some ex
 
‘Ready’
‘Read A
‘Downlo
 
Inverte

 
This sect
the drive
displaye
  
Example
 
22015:  
drive. Th
function
 
CIMR-G
 

Status Message
 
Figure 5.3a: Status Bar 

 Message 

ion displays what type of communication is taking place between the drive and the PC.  
amples are: 

: indicates the PC and drive are ready to receive commands.   
ll’: the PC is reading all the parameters currently stored in the drive 
ading all parameters’:  the PC is writing parameters to the drive 

r Information 

ion displays information pertaining to the drive model number and the part number of 
 software. When Ethernet communication is used the drive name and IP address are also 
d (see Fig 5.3b). 

:  ‘22015 / CIMR-G7*20P4’ 

These 5 numbers indicate the last five digits of the software part number loaded into the 
e database you have selected must include this number in order for DriveWizard™ to 

 properly. 

7*20P4:  This is the YASKAWA model number for the drive. 
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 Status Bar

 
 

 
Figure 5.3b: Status Bar Inverter Information with IP Address 

 
 
 
 
Status Icons  
 

  This icon indicates the progress of the initial communication from the drive to
DriveWizard™.  The arrow slowly forms left to right, and once the arrow is fully formed, the 
drive is done connecting. 

 

 
   These icons indicate if the DriveWizard™ Software is online with the drive. 
  Indicates when the DriveWizard™ Software is connected to the drive.  
  Indicates when the DriveWizard™ Software is not connected to the drive.  

 
  The blinking heart icon indicates the DriveWizard™ Software monitor mode is active  

 
  The blinking red bullet icon appears when the drive has a fault.   

 
 Indicates that Write Disable function is on  

 
 The lock indicates the when the factory parameters are accessible.  
  This icon indicates the factory parameters are not accessible. 
  This icon indicates the factory parameters are accessible. 
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 Parameter Editor Spreadsheet

  

Parameter Editor Spreadsheet 
  
  
Introduction 
 
The parameter editor is probably the most commonly used feature in DriveWizard™.  This is 
where the drive parameters are displayed and modified.  The parameters are divided in groups 
that have a tab or page at the top of the spreadsheet.  The drive parameters are listed in rows 
while the values and attributes for each parameter are divided into columns.  An example is 
shown in Figure 5.4 below. 
 

 
 

Figure 5.4: Parameter Editor Spreadsheet Example 
 
  
  

unction or purpose.  We call these parameter 
roups. These parameter groups will be shown as a page or tab on the Parameter Editor 

Spreadsheet.  In general there are four ways parameters can be separated into groups.  You think 

arameters within the group all have the same focus.  For example, some drives may have a 
“Term he parameters within this group would be related to adjustment of the 

ive.  

General Definition of Parameter Groups 
  
Drive parameters will be categorized by their f
g

of the groups as separated by Subject, Range, User Application, and Unique Function, 
although they are not referenced in this manner.   
 

• Subject 
P

inals” group.  All t
input and output (I/O) terminals of drive.            
 

• Range  
Parameters are all in sequence.  For example, one group may consist of the parameters from 
number one through forty- nine (n001 to n049).  Another group may be an extended range from 
one through seventy- nine (n001 to n079).  There will always be a group named “All”.  This 
would be an entire list of the parameters within the dr
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 Parameter Editor Spreadsheet

 
• User Application 

There is a special group of parameters, which configures a user defined programming display.  It 
is named the “User” group; however, it seems very few take advantage of this convenient 
feature.  The user group is used in conjunction with the access level.  Basically, it is a way to 
specify the most commonly used parameters for the application and have the drive display only 

e selected parameters.  Required parameters are selected under the “User” group tab.  The 
ccess level is set to “User level” access.  Once complete, only application specific parameters 

lay.    

  
Spreadsheet Column Definitions 
 
Each of the drive parameters has attributes su h as a maximum value, minimum value, the 
display units, and it’s factory lso, we need to see what is 
urrently stored in the drive memory as well as what the current value is in DriveWizard™.  To 
isplay all of this data in an easy to read manner the data values are divided into columns (see 

th
a
will be available, or shown on the keypad disp
 

• Unique Function  
There are a limited number of parameters that have multiple functions.  These parameters have 
been separated into their own parameter group to better support their unique capabilities.  Most 
often this will refer to the Password (access level) or initialization parameter.  In such cases, the 
name of the group will take on the number of the parameter. 
  

c
 default value to name several. A

c
d
Figure 5.5).    

 

 
 

Figure 5.5: Parameter Editor Columns 
 
 
To utilize the Parameter Editor Spreadsheet data effectively, we must understand the meaning of 
the columns.  A list and description of all available columns is below. 
 

- The actual drive parameter number may take the form similar to A1-01, n001, or 01    
 

– The name of the parameter that can be found on either the keypad display or in the 
manual.  It will usually correspond to the keypad display for drives with an LCD digital operator.  
For drives with an LED display, it will be similar to the manual. 
 

– This column is where the actual editing of the parameter data takes place.  It is a 
te

pload or download, the settings in the working value column will 
atch the inverter value column.  

mporary setting value used for making all adjustments before they are finalized and 
downloaded to the drive or stored in a file.  It is frequently different from those setting values 
within the drive.  After an u
m
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–The value of a specific parameter currently stored within the drive.  After an 

upload or download, the settings in the Inverter value column will match the Working Value 
olumn.  

 
c

– This is the engineering unit in which to set the parameter.  Some parameters have the 
bility to change the setting units of other parameters.  Please take note of any unit changes when 

adjusting 
a

parameter values. 
 

– This is the minimum allowable setting that can be set in the Working Value column.  
This setting may vary depending on the drive and size (KVA), control method, software version, 
etc.  
 

– This is the maximum allowable setting that can be set in the Working Value column.  
This setting may vary depending on the drive and size (KVA), control method, software version, 
tc. 

 
e

– This is the factory default setting for each parameter upon shipment.  This setting 
may vary depending on the drive and size (KVA), control method, software version, etc.  All 
parameters may be returned to default settings by initializing the drive. It is recommended to run 
the Initialize Inverter command from the Inverter menu when necessary.   
 

– This will indicate whether or not a parameter can be adjusted while the drive is 
running.  The word “Yes” will be displayed in the changeable column if the parameter can be 
changed while the drive is running or has been issued a run command.  
 

Parameter Editor Spreadsheet
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Working Value Cell Types 
 
The data in the working value column can be of two different types that are: 
 

• Numeric 
A numeric (Figure 5.6) cell allows any value to be entered into a cell as long as the value is 
within the minimum and maximum value range.  Decimal places will be added if left off and 
truncated if additional decimal places cannot be accepted.  Please make note of the units 
displayed in the adjacent column, as the support tool will not automatically convert your entry. 
 

 
 

Figure 5.6: Numeric Cell Example of Parameter E1-04 
 

• Selection 
Selection cells (Figure 5.7), or “pull-down” cells, have a fixed set of values that can be entered 
into the cell.  Once selected, the available options will appear. (Figure 5.8) 
 

 
 

Figure 5.7: Selection Cell Example of Parameter E1-03 
 
 

 
 

Figure 5.8: Selection Cell Value Example  
  

Parameter Editor Spreadsheet
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Cell Attributes 
 
Other useful parameter information is indicated in the parameter editor as well and are listed and 
described below.  
 

• Green Bullet 
  Appears in the left most column of the parameter editor when the setting has been 
adjusted in that session.  This status serves as a reminder as to what has been changed.  It will 
easily identify all the parameters adjusted since connecting to the drive or since opening an 
existing parameter file.  The user can modify any incorrect adjustments.  

 
 
 
The green bullet will only disappear if the Parameter Editor Spreadsheet is 
saved to a file or another data set is loaded into the spreadsheet. 
 
 
 

• Red Bullet 
 Appears in the left most column of the parameter editor when DriveWizard™ has 

adjusted the setting in that session.  This happens when a master parameter (Table 5.9) that 
other parameters are dependent on are changed. The software changes the values as the drive 
would if the master parameter had been changed by the drive keypad.  An example would be 
changing the control mode in G5 (parameter A1-02). 

 
The red bullet will change to a green bullet if the working value of the 
parameter is changed by the user after the software has changed that value.   
The bullet will disappear if: 

• All parameters are uploaded from the drive 
• All parameters downloaded to the drive 
• Parameters are saved to a file.   

 
For V7 only, the red bullets disappear when the master parameter is 
downloaded to the drive. 
 
 

 
Param Description Applicable Drive Param 

� 
Note! 

� 
Note! 

Parameter Editor Spreadsheet

Description Applicable 
Drive 

A1-02 Control Mode G5, F7, G7 n001  Initialize Mode V7 
C1-10 Accel / Decel Units  G5, F7, G7 n002  Control Mode V7 
C6-01 Normal / Heavy Duty F7 n018  Accel / Decel Units V7 
E1-03 V/F Pattern  G5, E7, F7, G7, P7 n035  Display Mode  V7 
o1-03 Display Units  G5, E7, F7, G7, P7  KVA Setting   V7, J7 
o2-04 KVA Setting  G5, E7, F7, G7, P7 n01  Initialize Mode  J7 
o2-09 Initial Setting G5, E7, F7, G7, P7    

 
Table 5.9: Master Parameters 
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• Underlined Data 

An underline is an indication something has changed.  If the setting in the Working Value 
column has been adjusted or changed from factory default, the values in the Inverter and Default 
columns will be underlined.  The only exception to this occurs after a read from the drive or 
write to the drive is executed.  At this point, the Working and Inverter values will be the same; 
however, the adjusted values may be different from factory default settings.  In this case, related 
values in the Default column will be underlined.  
 
 

• Colored Text 
Blue or Red text (if supported by computer) will indicate something has changed (Figure 5.10).   
 
Blue Text indicates that the Working Value column has been adjusted or changed from factory 
default. The text color in the Inverter and Default columns will be blue.  The only exception to 
this occurs after a read from the drive or write to the drive is executed.  At this point, the 
Working and Inverter values will be the same; however, the adjusted values may be different 
from factory default settings.  In this case, the text color in the Default column will be blue.  
 
Red Text indicates that the Working Value is out of range for that parameter. 

 
 

If there is an underline and/or red text in the Working Value Column, this 
indicates a value has exceeded the acceptable setting range for a 
parameter.  It is strongly recommended you change the value within 
range before saving or downloading.  Trying to download an out of range 
parameter will mostly cause a Modbus communication error and/or cause 
a drive alarm or fault.   

  
 
 
 
 
 
 
 

 
Important ! 

e 

Parameter Editor Spreadsheet

 
Figure 5.10: Colored Text Exampl
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• Shaded Cells 

 
A shaded cell indicates a parameter cannot be adjusted (Figure 5.11).  Shaded cells may appear 
when other parameters restrict adjustment.  An example would be a fixed or predefined V/F 
pattern.  When a fixed V/F pattern is selected, this automatically configures values for a number 
of points on the V/F profile.  Parameters related to these points would be in shaded cells since 
those parameters can no longer be adjusted.    
 

        
  

Figure 5.11: Shaded Cells      
  
 

Changing Parameter Values 
 
The following examples will guide you through the changing of a drive parameter in the 
Parameter Editor Spreadsheet: 
 

• Numeric Parameter Change 
 
To change the value of a parameter in a numeric cell, single left click on the parameter’s current 
value in the working column and enter the value to change it to.  If the value is out of the Min to 
Max range, the value will appear as red underlined text.   
 
 

 

 
 
 

Figure 5.12: Changing a Parameter Value 

  

n  

 

Parameter Editor Spreadsheet

 
 

• Selection Parameter Change 
 
To change the value in a selection cell, left click once on the cell.  A dia
prompting you with allowable values you can change the parameter to.  An 
Figure 5.13.   
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Data Entry 
Selection Cell
Working Value Colum
 Out of Range Entry
Shaded Cells
log box will appear 
example is shown in 



 

 
 

Figure 5.13: Example of Changing Selection Cell Parameter B1-04 
 

 
 
Select the value to change it to from the pull-down list (Figure 5.14) and click on the Accept 
button to go ahead with the change.  To cancel the change, click on the Decline button and the 
dialog box will disappear and no change will occur to the working value. 
 

 

 
 

Figure 5.14:Cell Selection List for Parameter B1-04 
 
  
Differences Tab 

There is a special tab at the far right-hand side of the parameter spreadsheet tabs named 
Differences (see Figure 5.15).  This tab shows a list of all of the active parameters that are either 
blue or red (different than factory defaults).  This tab is constantly updated so any changes to 
parameters are instantly shown on this view. The view can be printed the same as other 
parameter groups. 
 

 

 
 

Figure 5.15: Differences Tab  
 

Parameter Editor Spreadsheet
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 Parameter Editor Spreadsheet

 
Adjusting Windows and Column Widths 
 
The working environment can be called a flexible grid - all windows and cells can be adjusted to 
the user’s liking. If a window is not necessary, it can be sized to no longer be visible. If all the 
columns cannot be seen, the window can be expanded accordingly. The same sizing applies to 
individual columns within the main windows. The mouse pointer will change when a window or 
a column can be resized, as shown in Figure 5.16 and Figure 5.17 below.  
 
 

 
 
 

(a) Width Adjustment             (b) Height Adjustment 
 

Figure 5.16: Mouse Pointer When Resizing Option is Available 
 
 
 
 
 
 

  

Column Width Adjustment 

  
Figure 5.17: Column Width Adjustment    
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Chapter 

6 
  
  
  
  

Monitoring 
 
This chapter describes the functions and features monitoring drive data 
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Introduction  
  
  
The monitoring function in DriveWizard™  is used to collect and display data from the drive in a easy to 
read format.  When this function is in operation, DriveWizard™ constantly refreshes the monitor display 
ever 500 mS. All of the data that can be monitored from the operators keypad plus additional internal 
drive data are available for monitoring. The monitor window is a spreadsheet just like the Parameter 
Editor spreadsheet such that the columns and the monitor window can be re-sized.  
 
The monitored data can be graphically displayed in the graphing function that is covered in the next 
chapter.  
 
 
 

 
 

Figure 6.1: Example of Monitor Window 
 
 
 
 

 
 
1.  The monitor items available to the user for display are drives specific. 
 
2.  The monitor setup is saved per drive type (i.e.: G5, V7, F7, etc.) when 
going offline. 
  

� 
Note! 

Introduction
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 Using the Monitor

 

Using the Monitor 
  
 
This section will show you step by step how to set up and activate the monitor function of 
DriveWizard™.  
 
To start monitoring follow these steps: 
 
1. Connect the drive to the PC as described in Chapter 3 
 
2. If parameters need to be changed, do this now (refer to Chapter 5: Parameter Editor)  
 

3. In the Monitor area, click on the Setup Tab ( ).  Choose the parameters to watch by 
left-clicking once in the box next to the parameter number.  All parameters with a check in 
their box ( ) will be displayed under the Monitors Tab.  To unselect a parameter, simply 
left-click again and remove the check from the box ( ) next to it (see figure 6.2) 

 
 

 

Monitor Items 
Appear on 

Monitors Tab 

Monitor Items 
Do Not Appear 

on Monitors Tab 

 
Figure 6.2: Example of Monitor Setup Window   
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4. Click on the Monitors Tab ( ).  All of the parameters selected in step 3 should be 
displayed.  If they are not, go back to the Setup Tab and make sure there are checks in the 
boxes next to the parameters to be observed. The value column will be blank when the 
monitor is turned off. 

 
 

 
 

Figure 6.3: Monitor Window with Monitor Stopped 
 
 
5. Click on the Start command under the Monitor Menu (or  from the Tool Bar) to start 

monitoring the selected parameters.  DriveWizard™ will start continuously monitoring these 
parameters for changes in these values, and their values will be displayed under the Monitors 
Tab. Note that the red heart in the lower right hand side of the status bar is flashing, 
indicating that DriveWizard™ is monitoring the drive. 

  
  

  

  
  

Figure 6.4: Monitor Active – Heartbeat Icon 

Using the Monitor

Monitor Active 

 

  

orrectly during monitor operation.  
  

  

  

� 
Note! 

 
On the GPD315/V7,  n152 (Memobus Ref Units) must be set to 1 for the 
scaling of Frequency Ref (U-01) and Output Frequency (U-02) to read 
c
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 Using the Monitor

 
Display features 

 
The monitor tab display can be changed to better view the monitor data: 
 

• Viewing Bit Data 
The display can be expanded to display detailed data on individual bits that are part of a monitor 
item.  You can tell if a monitor item is a bit display by the fact that the units, min, and max 
columns will have dashes (--).  To expand or collapse a bit value display, simply left click on the 
number cell of the monitor item and the display will change to show or hide bit information.  
 
 

 

 

 
Figure 6.5: Monitor Window with U10 Display Collapsed 

 
U10 Bit Monitor

 
 

 
 

Figure 6.6: Monitor Window with U10 Display Expanded 
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  Fault History 
 
 

YASKAWA ELECTRIC AMERICA drive products use fault codes to annunciate 
failures due to internal or external problems.  They also utilize a fault history to store previous 
fault codes.  Normally, up to 4 fault history codes may be held for GPD515/G5 and GPD315/V7 
and up to 10 fault history codes for E7, F7 G7, and P7.  These codes and all retrievable fault 
history are available by accessing the Fault History Tab. 
 

To activate a function to be monitored, the drive must be online, and the DriveWizard™ 
software must be in Monitor/Start mode. Click on the Fault History Tab, and a window similar to 
that in Figure 6.7 will appear. 
  

 
  

Figure 6.7: Fault History Tab for the Monitoring Functions 
  
A brief description of the fault is given under the Fault Description column.  A brief description 
of the fault and its possible causes may be obtained by a single right click and the fault that has 
occurred (Figure 6.8).  For more information on the Faults displayed, refer to the appropriate 
drive’s User Manual. 
 

  
  

Figure 6.8: Dialog Box for the Fault U2-01  

Fault History
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Chapter 

7 
  
  
  
 

Graphing 
 
This chapter describes the functions and features for graphing drive data 

104 



 Introduction

  

Introduction  
 
 
The graphing function in DriveWizard™  is used to collect and display data from the drive in a 
graphical format.. Up to 8 monitor values can be graphed at the same time. These monitor values 
can be any item available from the monitoring function (see Chapter 5). The time base for 
sampling is settable by the user in 1,10, 30, and 60 second intervals under serial communications 
and 0.1,1.0, 10.0, 30.0 and 60.0 second under Ethernet communications.  The graphing display 
can be re-sized to expand or shrink either the X or Y axis of the display. 
 
 

 
 

Figure 7.1: Sample of the Graphing Area 
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 Using the Graphing Function

  

Using the Graphing Function 
  

 
To start graphing follow these steps: 
 
1. Connect the drive to the PC as described in Chapter 3 
 
2. If parameters need to be changed, do this now (refer to Chapter 5: Parameter Editor) 
 

3. Click on the Graph Tab ( )  in the monitor area to display the graphing area. A 
display similar to Figure 7.1 will appear.  Before using the graphing function for the first 
time, the function must be setup.  On the right side of the Graph tab you will see a row of
buttons (Figur

 
e 7.2). 

 

 
 

Figure 7.2: Graph Control Buttons  
 

 
4. Click on the Setup  button on the right of the graphing area and the tab for Graph #1 will 

appear (Figure 7.3). 
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Figure 7.3: Graph Setup Window 

setup the graph: 
 
To 

a) Choose what to graph from the Graph Selection pull-down menu (Figure 7.4). 
 symbol as you like.  Refer to Graphing 

Function Details later in this chapter for more details on how to set these items. 
b) Edit the line width, scale, line style, and line

c) To graph more items, click on an unused Graph # Tab (for example, ). 
) and b) for this new tab.  A maximum of 8 items may be graphed at one And repeat a

time.   
d) Click the OK  button to exit Setup. 

 
 

Using the Graphing Function
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Figure 7.4: Selection of Graph Monitor Selection 
 
5. You selections should now be listed below the graph spreadsheet (see Figure 7.5).  If they are 

not, go back into the setup section and check your settings. 
 
6. If you wish, the sample rate or time per data point can be set to a different value other than 

the default of 1 second. Go to the graph properties by clicking on the graph Properties    
button.  Select the desired sample time. (refe to Graph Properties later in this chapter). 

 
7. Once the items to be graphed have been chosen, it may be beneficial to put a title on the 

graph, change the background color, or change the grid’s appearance using the Properties 
Button.  mation. 

 

r 

Refer to the Graph Properties Button later in this chapter for more infor

8. To begin graphing, press the S ge to a Stop  button.  The tart  button.  It will then chan
computer will start graphing the item(s) listed below the graph. 

 
9. When you have obtained the data needed or wish to graph different parameters, push the 

Stop  button to stop the computer from graphing.  At this point, the graph may be examined 
using the zoom arrows, printed and/or saved to a file for later use. 

 
10. To begin a new graph, press the Clear  button. 

  
 
DriveWizard™ will save the graph setup when going off-line from the drive. 
The settings will be saved per drive type (i.e. G5, V7, F7, etc.) � 

Note! 

Using the Graphing Function
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 Graphing Function Details

  

Graphing Function Details    
  
 
Setup Functions 

 
To setup the graphing function, click on the setup button located on the right side of the graphing 
tab window.  Each graph setup tab corresponds to a row under the graphing display. 

 
 

(a): The Setup Tab for Graph’s #1 
 

 
 

(b): The information selected under the setup tab is displayed below the graph  
 

Figure 7.5:Graph #1’s Setup  
 
Each Tab at the top of the Setup window indicates a different possible line to use for graphing.  
The information selected in that tab will be displayed in a table under the graph.  For example, 
Graph #1’s information is displayed under the graph next to the number 1 (Figure 7.5).  Each 
Graph number may be set to graph a different selection. 
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 Graphing Function Details

 
The data being graphed is determined by what is selected from the Graph Selection pull-down 
menu.(Figure 7.6). 
 

 
 

Figure 7.6: Graph Selection Pull-down Menu 

 
Clicking the Color  button can change the color of the graph line. To pick the color of the line 
displayed, simply click on the box of the color you would like.  A dotted line will appear around 

the box to indicate the line will be displayed in that color ( ) (see Figure 7.7).   
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To select a different color, simply click on the new color. 
 

 
 

Figure 7.7: Color Selection Menu 
 

: 
eing graphed.  When selecting line thickness, 
xample, if line 3 is thicker than line 1, line 3 

 is still seen displayed 
mallest line number has 

Line Width determines how thick the line is when b
the latest line will be foremost in the graph.  For e
will be seen and not line 1; however, if line 1 is thicker than line 3, line 3
over line 1.  To avoid accidentally hiding a line, always make sure the s
the largest width. 
 
 

: 
Scale determines what the value of the item being graphed is multiplied by while being graphed.  
This does not affect the scale of the value displayed in the Value column below the graph.  This 
is very useful for observing items with small changes in value (example: while graphing DC Bus 
Voltage with very little load). 

 
The graphing scale of 1 = 100% which is the maximum defined by the 
monitor scaling. Example: U1-17 is the analog input with a scale maximum 
of 200%.  With a graphing scale of 1, the graph line will be at 50% when the 
analog input is 100%. 

� 
Note! 

Graphing Function Details
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 Graphing Function Details

 

: 
Line Style determines what type of line the graph will use when displaying data.  What type of 
line is being displayed for a particular item may be seen under the Line column below the graph.  
The following options are available for displaying lines:  
 
0) Solid   

 1) Dash  
2) Dot   

ot  3) Dash D  
4) Dash Dot Dot  
 
 
 

: 
Line Symbol determines what type of symbol will be displayed with that item’s line on the
graph.  The symbol being used for a particular item may be seen in the Symbol column below
the graph.  The options for symbols are: 
 

 
 

) None   
) Circle  

0
1  
2) Rectangle   
3) Triangle   

 4) Diamond  
 
 
Start/Stop, Clear, and Print Buttons   

ce the 
tart button has been pushed and graphing started, the Start button will change into the Stop 

ill appear. 
 

 
The following buttons control the basic actions of the graphing function 
 
The Start button starts the computer graphing the parameters chosen in the setup menu.  On
S
button.  Push the Stop button to stop graphing the chosen parameters.  If the Start button is 
pressed when no parameters have been selected for graphing, Figure 7.8 w
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Figure 7.8: Reminde ng to Start Graphing r to Select Parameters before Attempti
 
 
The Clear button is only available after parameters have been graphed and only when graphing 
is not currently taking place.  This button deletes the current data held in the graph.  This also 
llows new items to be selected under setup and graphed. 

 
a

The Print button will print the graph area currently seen in the viewing window of the graph.  It 
will also print the graphing start time, drive type, and software version of the drive connected to 
DriveWizard™.  The print function uses the default Windows printer (see Chapter 4, Print 
Param). 
 
 
 
 
Save, Save As, and Load buttons 
 
The following functions are used for storing and retrieving graphs of data that have been 
retrieved from the drive. 
 
The Save  button saves the graph.  If the graph has not been saved before, a window will appear 
prompting you to enter a name for the file along with a file description.  
been saved under a file name, clicking this button will sim
 

If the graph has already 
ply save over the previous file.   

Thie Save As  allows the graph to be saved u ame.  A window will appear nder a different n
prompting you to enter a name for the file along with a file description.   

Graphing Function Details
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The Load  button allows a previously saved graph to be loaded onto the screen and examined 
from there.  A graph may only be loaded when the drive is not connected to DriveWizard™.  
After clicking this button, a window will prompt you to choose the graph you wish to load 
(Figure 7.9). Clicking the Cancel  button in this window will exit the load operation. 

 

 
 

Figure 7.9: Opening a Graph Screen 
 
Clic   Before the graph is loaded, another screen will appear k the Open  button to load the graph.
wit  the file description entered a e the graph was saved.  Click h t the tim Load  to finally load the 
graph or click  to be taken back to the list of possCancel ible files to open.  (Figure 7.10) 
 

 
 

Figure 7.10: Graph Loading Screen 
 
 

Graphing Function Details
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Graph Properties Button 

The   
 

 
 graph properties button brings up a window that sets up the main graphing display attributes.

Graphing Function Details

 

hT
 
1)

 
2)

 
3)

 
4)
1

 
3
 

 

 
Figure 7.11: Changing Graph Display Properties 

 
ere are five attributes that can be set in this window: 

 The title of the graph is entered into the Graph Title  box.  Once the OK button has bee
pushed, the title is displayed centered above the graph area.  

 Push the Back Color  button to change the background color of the graph.  To pick the
click on the box of the c ll appear around the 
indicate the color th e displayed as (

olor you would like.  A dotted line wi
)e graph’s background will b .  To select a di

color, simply click on the new color. 

 The pull-down menu next to Grid  has four options. 
0) None:  The grid is not displayed. 
1) 

are displayed. 
3) Both:  Horizontal and vertical grid lines are both displayed. 

Horizontal:  Only horizontal grid lines are displayed. 
2) Vertical:  Only vertical grid lines 

 The color of the grid may be changed with the Grid Color  button.  To pick the grid
simply click on the box of the col

r, simply cl
the new color. 

or you would like.  A dotted line will appear around th
to indicate the grid will be displayed as that color.  To select a different colo
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 Graphing Function Details

 
5) The Sample rate  of the graphing data or the amount of time per point can be set with this 

drop down box. Clicking on the down arrow will display a list of sample rates available (Fig 

• Serial Communications: 1, 10, 30, and 60 seconds can be selected (100 mS NOT 
available.) 

nds can be selected. 

7.12) Select a new sample rate and click on OK to close the window.  The default rate is 1 
second 

• Ethernet Communications: 0.1, 1, 10, 30, and 60 seco
 

 
Figure 7.12: Sample Rate Selections (Ethernet Shown) 

  
raph Column Definitions G

 
There is a spreadsheet under the graphing chart that shows all of the monitor points that are 
being graphed and the current value of the graphed monitor points (Fig 7.13). 
 

 
 

Figure 7.13: Graph Spreadsheet Columns 
  

- The color of the line being graphed. 
 

- The type of line used for graphing (ie solid, dash, dot, etc) 
 

- The symbol here matches the symbol on the line for that parameter.  If this box is blank, 
no symbol will be displayed on the line. 
 

- These are the numbers of the parameters currently being graphed. 
 

- A brief description of the parameter being graphed.  This 
name typically matches the description given in the appropriate drive manual. 
 

- Displays the value of the parameter being graphed.  While graphing this number is 
eter.  If graphing is not taking place, click on a point in the graph

and the value of that point will be displayed here. 
the current value of the param  

 
- The units the parameters are displayed in. 
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- The scale at which the parameter is being graphed. 
 

- After graphing, this is the lowest value the parameter reached over the course o
the whole graph.  If nothing ha

f 
s been graphed ye , this (--) is displayed. 

 
t

- After gr phing, this is the highest value the parameter reached.  If nothing has 
been graphed yet, this (--) is displayed. 
 
  
Changing the Graphing Window (‘zooming’) 
 

of the graphing window can be resized or zoomed in or out to 
ved analysis.  The zooming is done via mouse dragging of graph 

 
onitors Tab.  The number in the Max column equals 100% on the vertical scale. 

 
To zoom in on the vertical scale, pull the top arrow towards the bottom arrow and vice-versa.  
For example, when DriveWizard™ is initially started, the vertical scale goes from –150% to 
150%.  To zoom in on the 0-100% area, pull the bottom arrow (

a

The vertical and horizontal axis 
highlight the data for impro
display controls (Fig 7.14). 
 
The vertical scale has a range from –150% to 150% of the maximum value of the parameter 
being graphed.  100% of the value being graphed may be found by selecting the parameter being 
graphed under the Setup Tab in the monitors area and then examining the Max column under the
M

) up until only the 0% and up 
gridlines are displayed.  Then pull the top arrow ( ) down until 0-100% is displayed. 
 
The horizontal scale starts with a 0-60 second window displayed.  This window can be shrunk 
with the zooming arrows, or the window can increase if the graph runs for greater than 60 
seconds.  The arrows may then be dragged apart to view the entire graphing time period.  
Likewise, after graphing, the arrows (  , ) may also be dragged closer together to zoom in on 
something or farther apart to zoom out. 
 
 

 

 

Graphing Function Details

 

Ho
Vertical Scale Zoom
Figure 7.14: Graph Zoom Controls 
rizontal  Scale Zoom 
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For both the horizontal and vertical scales, the cursor can be positioned in-
arrows until a doubled sides arrow (

b le’s etween a sca
) appears.  Drag this left and right to

window you have zoomed in on.  For example, a 0-10 second window can
the 20-30 second time period. 

  
 
 
If the graph is cleared, the horizontal scale must be re
by dragging the right arrow all the way right and the 

  
  
  

 
Graph Time Display 
 
There are two displays that show the amo
lapsed time readout on the lower left-hand

e marker. (Fig 7.15)  
 

 move the whole 
 be moved to display 

set also.  This is done 
left arrow back to 0. 

unt of time that the monitor data was stored.  An 
 side shows the total time the graphing was on.  A e

time display on the lower right-hand side shows the time at the vertical tim

 
 
 
 

A ver
graph
spread
this fu

� 
Note! 

e 

Graphing Function Details
Total Stored Tim

 
 

Figure 7.15: Graph T
 

e far left-hand sidetical bar (normally at th  
.  The time stamp will show the time at
sheet will show the data value at the bar.  T
nction. 
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Time Stamp at Vertical Bar
ime Data Marker 

of the graph display) can be dragged over the 
 the bar.   The value column of the graph 
he graphing must be in stopped in order to use 
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This chapter describes the functions and features of the Run Wizard 

Run Wizard 

8 
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Activating Run Wizard  
  
  
The Run Wizard allows remote control of a drive.  This feature is only available after 
communication with the drive has been established, and it has been enabled.  The following 
sections illustrate the use of this feature. 
  
1. Connect the drive to the PC as described in Chapter 3 
2. If parameters need to be changed, do this now (refer to Chapter 8: Parameter Editor)  
3. Click on the Enable  button in the Run Wizard (Figure 8.3a) 
4. If this is the first time you are enabling Run Wizard the warning in Figure 8.1 will appear.  

Click on Accept  to continue, click Decline  to stop the function. 
5.  The warning message in Figure 8.2 will appear. Click OK  to continue. 
 

 
 

Figure 8.1: Initial Run Wizard Warning Window 

 
 

 
 

 
 

Figure 8.2: Run Wizard Warning Window 
 
 

Activating Run Wizard
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6. The Run Wizard is now enabled and Figure 8.3b should appear 
 

  
 

Figure 8.3a: Before enabled  Figure 8.3b: After enabled 

 
has an alarm or fault.  

ault is present. 
lt is active as this will prevent 
ad removal detection 

515/G5,E7, F7, G7, 

u must be in the RunWizard 
tup, Chapter 4) 

  
7, 

and P7 and N003& N004 on GPD305/J7 and GPD315/V7 when enabling 
RunWizard. These parameters are set to their prior settings when 
RunWizard is disabled. If communication is lost while using RunWizard, 
you must change these settings back to their prior settings. 

tion 

 
 

  
 

1. The Run Wizard will not enable if the drive 
Check the status bar to see if an alarm or f

2. Check also to see if the keypad removal fau
Run Wizard from operating also. The keyp
enable/disable parameter: GPD315/V7 = n10;  GPD

� 
Note! 

P7 = o2-06. 
3. When using Ethernet communications, yo

Allowed mode. (See Communications se
  

  

1. RunWizard sets B1-01 & B1-02 to setting 2 on GPD515/G5, E7, F7, G

2. This feature is locked out when you have the Write Disable func
turned on. 

  

 
Im

Activating Run Wizard

portant ! 
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Using Run Wizard 
 
After Run Wizard is enabled, enter the value (in Hertz) to run the motor at in the Speed Ref  
box.   
 

 
 

Figur Reference Bo
 
 

To run the motor in the forward direction, click on the 

e 8.4: Run Wizard Speed x 

Forward  b l arrowutton.  A smal  will slowly appear across the 
bottom izard window to indicate the motor is moving 
in th  dire ure 8.5a).  T lick on 

 of the Run W
at ction (Fig o stop running the motor, c

the STOP  button .  
To change the speed of the drive while running, enter the 

new sp ed in the speed reference rward   e  box and click on the Fo
butto  to s eed com
 
        
        F ure 8 g Forward 
 
 

n end the new sp mand to the drive 

ig .5a: Motor Runnin

To Reverse   run the motor in the reverse direction, click on 
button A  will slow
Run W zard window to indicate the motor is moving in the reverse 

irection. (Figure 8.5b).  To stop running the motor in the reverse 

.  
i

small arrow ly appear across the bottom of the 

d
direction, click on the STOP  button.      

To change the speed of the drive while running, enter the 
new speed in the speed reference box and click on the Reverse  
button to send the new speed command to the drive 

      
  
 
        Figure 8.5b: Motor Running Reverse 
 

 
 
 
The Run Wizard will become disabled if the drive has an alarm or fault.  
Check the status bar to see if an alarm or fault is present. 
 
          
         

� 
Note! 

Using Run Wizard 
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Appendix A: Toolbar Icons 
 
 
� Drive Wizard™ Toolbar Icons: See Chapter 4 for more detailed descriptions. 

 Nam sc ilable 
 

e De ription When Ava
 Open Opens a param  offline eter file Drive is online or

Save  or 
ive 

Saves a parameter file After file opened
After connected to dr

 

Print Prints a parameter file  file opened or 
 drive 

After
After connected to

 

Start Mon
Mode 

 activity or Mode itor Starts monitoring drive  While not in Monit 

 Stop Mon
Mode 

o  activity  Mode itor Stops monit ring drive  While in Monitor

 Connect Connects Dri ™ 
software to an drive 

 veWizard Drive is offline

Disconnec isconnects D rd™ 
software from an drive 

 t D riveWiza Drive is online 

Write Sing
Parameter 

Updates a single parameter in t
drive 

line le he Drive is on 

Write All 
Parameters 

 all p
drive 
Updates arameters in the Drive is online  

Read Sing
Parameter 

Reads a singl
drive 

le e parameter in the Drive is online  

Read All 
Parameters  

l para  the driv Reads al meters in e Drive is online 
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Appendix B: Quick Reference Guide 

Command Name Shortcut Description 

 
 
  
 

Save Parameter File Ctrl + S Saves parameter file 
Save Parameter File As Ctrl + A Saves parameter file 

with a specific name and 
location 

Close Parameter File Ctrl + E Closes parameter file 

File Operations 

Compare Parameter File Ctrl + B Compares 2 parameter 
files 

Communication Communication Setup Ctrl + P Allows settings to be 
changed 

Connect Ctrl + C Opens connection 
between PC and drive 

Disconnect Ctrl + D Closes connection 
between PC and drive 

Read All Ctrl + U Downloads all 
parameters to PC 

Read Single Parm Ctrl + Shift + U Downloads selected 
parameter to PC 

Write All Ctrl + Shift + D Uploads all parameters 
to the drive 

Inverter 
Operations 

Write Single Parm Ctrl + O Uploads single 
parameter to the drive 

Start Ctrl + G Starts monitoring mode Monitoring 
Stop Ctrl + Shift + G Stops monitoring mode 
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Appendix C: Menu Flow Chart 
 
 
 
 

DriveWizard Menu
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Pri
Pa
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m File 
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Write Single 
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Password 
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Ne
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ppend

he supported drives and software numbers that each database 

rive 
Family 

Drive Type Spec 
Type 

Drive Software 
(Flash Software) 

Database Selection 

A ix D: DriveWizard™ Supported Drives 
 

he following tables show tT
supplied with DriveWizard™ will support. 
 
 
D

G5 A, U 1032 ~ 1043 Standard 
G5 CASE U G5 CASE (1042)  2000 ~ 9999 
G5 575V U 5391, 5392, 5480 G5 575 V 

G

G5+ A, 1110 ~1114 Standard 
G5 HHP A,U 5291, 0210 G5 HHP Std/450A (old) 
G5 HHP A,U 5293, 0211 G5 HHP Std/450A (new) 
G5+ HHP 1P U 6991 G5 HHP 1PU 

5 

G5+ CASE U 2000 ~ 9999 Generic CASE 
C, U Any Software Standard E7 E7 HVAC 
U E7+ VSE104010 and above E7+ / P7+ 

F7 Std A, C, U Any Software Standard F7 
F7 CASE U Generic CASE Any Software 
G7 Std A, C, U Any Software Standard G7 
G7 CASE U Any software G7 Generic CASE 

J7 J7 Std A, C, U 10 ~ 21 Standard 
U Any Software Standard P7 P7 Std 
U P7+ VSP121020 and above E7+ / P7+ 

V7 std A, C, U 20~30, 100 ~ 110 Standard 
V7 CASE U Per Specific Software Special Databases 
V7N U 0010 V7N 
V7 NEMA 4 U VSP018230,VSP018240 V7 for NEMA 4 
V7N NEMA 4 r NEMA 4 U VSP035000, VSP035010 V7 with DeviceNet fo

V7 

GPD315/V7 
CMO9x Ethernet 

U VSP018340 
VAP018350 

V7 Ethernet 

M5 M5 U VSM20094 Not Supported 
MC5 MC5 422 Not Supported U 5423, 6420, 6
PS5 PS5 U 1014,1016,1021, 1023, 

1024, Special Software’s 
PS5 Database 

 
Table D.1: Standard Databases supplied with DriveWizard™
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Appendix E: Factory Only Features 

le.  Factory Password prompts (Figure E.1) the 
user to enter the password that allows these parameters to be adjusted.   
 

 
 
Factory Password   
 
Factory parameters can have severe effects on system performance, and therefore are usually not 
adjusted without a factory representative availab

 
 

Figure E.1: Factory Password Entry 
 

On the status bar, the lock ( ) indicates whether the factory parameters have been unlocked or 
not.  Factory Password e access to parameters which can normally only be altered by 
the factory.  Once the cor eters have been unlocked 

unlocks th
rect password has been entered, the param

( ).  See Figure E.2. 
 
 
 

 
 

Figure E.2: Status Bar 
 

Entering the factory password also allows Flash to be written to the drive.  The Flash Write 
option appears under the Inverter Menu and will become visible anytime after the factory 

assword has been entered but will be grayed out and unavailable if DriveWizard™ is currently 
online with the drive.  

 
mode: 
orking value of the access 

level (n01, n001, or A1-01) to any of the non-factory access levels, it will 
go back into ‘locked’ mode. 

tializing and re-
uploading, it will remain in ‘unlocked’ mode until the user clicks 
‘accept’ with a working value other than factory access. 

t 

� 

p

Situations that can cancel Drive Wizard’s factory 
1. Online or offline, if the user changes the w

2. Online, if the access level (n01, n001, or A1-01) gets changed by the 
software, either by opening another file or by ini

3. Offline with a factory access file open, opening another file will put i
back into ‘locked’ mode. 

Note! 

Factory Lock 
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lash Write  

 
New software and updates may be loaded into the drive with this command.  This option is only 
available after the correct Factory Password has been entered and DriveWizard™ is not on-line 
with the drive.  If the Factory Password is entered while the drive is on-line, Flash Write will 
appear, but will be grayed out and unavailable.  

 
 
Flash Write is only available under Serial Communications.  You cannot use this 
function with Ethernet Communications. See Communications section of Chapter 4 
 

 
 
To write flash, choose Factory Password from the Inverter menu and enter the correct password.  
Flash Write should now be available under the inverter menu.  Click on it and Figure E.3 Should 
appear. 
 

F

 

 
 

Figure E.3: Opening a File with Flashing Data 
 
Select the file with the flash data in it and click the Open  button to proceed.  A warning will 
appear (Figure E.4) because once the new data is written to the drive, the old data cannot be 
retrieved.  
 

 
 

Figure E.4: Confirmation to Flashing a Drive 
 

� 
Note! 
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If the file selected is not of the correct type, Figure E.5 will appe
 

ar. 

 
 

Figure E.5: Attempting to Open an Invalid Flash file  
 
 

Clic o start the Flash Write process.  Click on No  to not write flash and close the k n Yes   to 
Fla W n.  Once flashing has started, a progress bar (Figure E.6a) will appear until 

e drive is flashed successfully  (Figure E.6b). 
  

sh rite functio
th

 

   
 

(a).  Progress Bar During Flashing   (b).  Successful Flash 
 

Figure E.6: Flashing a Drive 
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Appendix F: Adding a Database 
s custom software’s and special drives are created, DriveWizard™ accommodate these items by the 

reation of additional databases not supplied with the original DriveWizard™ installation.  The database is 
dded in the same manner as a program is installed on your PC. 

o add a database to your existing DriveWizard™ installation, please follow this procedure: 

es can be found at/on the following: 
tp://www.yaskawa.com/site/products.nsf/products/DriveWizard.html

A
c
a
 
T
 
1.  The Additional databas

• On the internet at: ht  under 
. 

• CD.V7J7.01 
• CD.E7.01 
• CD.DW.01 

 The installation files are contained in a WinZip file that you can copy to any directory on your PC 
hard drive. Copy the zip file to your hard drive. 

.  Unzip the files (refer to Chapter 2 – installation for more details) 

.  Close all other application programs running on your computer. 

file called Setup or Setup.exe .  Double click on that icon to start 
tion program will start and a welcoming screen will appear 

 

 

 
 
 

the d nownload sectio
• CD.AFD7.01,  

 

 
2
 
3
 
4.  In the unzipped files you will find a 

the installation process.  The installa
 
 

 

 
 

 
 
 
The welcoming screen 
will look like this. 
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A m

DriveW

 
 

 

ess
welcoming you to the 

age will appear, 

izard™  program. 
Click Next  to continue. 
 
 
 
 
 
 

 

 
 
A wind
databas
con

 b
e

 

 
 

ow will appear listing the 
e(s) that this installation 
s.  Select all tain the databases 

to e installed by clicking on the 
ch ck box. 
 
Now click on Next .  The 
in allation will complete and 
th  clo

st
en

program

t
Chapte
 
 

se the installation 
.  Check for the new 

database under File > Change 
Da abase in DriveWizard™ (see 

r 3) 
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� Appendix G: Release History 
 
DriveWizard™  6.1 Release A
  

pril 2006 

• G5
aved standard G5 drive 

• GP

ct a 
 up 

• Sup

• 

 drive.  You cannot change any 

20 

• Sta
itional DriveWizard™  database supplied with 

the software. 
• V7 Ethernet Database 

This feature adds GPD315/V7  support for Ethernet when using a CMO9x 
communications option for GPD315/V7 by an additional DriveWizard™   database 
supplied with the software. 

 to G7 File Conversion Tool. 
This feature allows the user to convert a previously s
DriveWizard™  parameter file into a standard G7 drive DriveWizard™ parameter file.   
D505/P5 & GPD506/P5+ to E7 & P7 Conversion Tool. 
This feature allows the user to convert a previously saved standard GPD505/P5 or 
GPD506/P5+ drive parameter file in InverterWin 3.0 into a standard E7 or P7 

le.  DriveWizard™ drive parameter fi
• Enhanced Ethernet drive multiple IP address storage. 

This feature allows the user to create a list of IP addresses as long as they wish to sele
he drives can also have a tag namedrive to connect to in Ethernet communications.  T

to 32 characters associated with it’s IP address to easily find a particular drive in a long 
list of IP addresses. 
port for Ethernet Modbus TCP/IP and Ethernet/IP 
Both Ethernet protocols are now supported in DriveWizard™. 

 Drive Write Protect added. 
This feature allows the user to set a password and enable the write protect function.  
When this function is turned on, the user of DriveWizard™ can only monitor the drive, 
view drive parameters, and upload parameters from the
parameters, download parameter files, initialize the drive, reset the drive, or utilize 
RunWizard. 

• Drive Remote Reset Capability 
The ability to reset a drive fault while on-line with DriveWizard™ has been added. 

• E7+ / P7+ Database 
This additional database supports the new featured E7+  4010 software and the P7+ 10
software’s. 
ndard G7 CASE database 
This feature adds G7 CASE support by add
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DriveWizard™  6.0 Release September 2004 

• G5

load KVA and Control Mode Skip 
drive 

lication to different size or rating of drives along with 
n or closed loop control. 

• Sav

e the differences between files or a file and online drive for future use.  
Variable Time Base Added to Graphing Function 

ng with Ethernet communications has 
 now adjust the sampling rate from  0.1 

seconds to 60 seconds per sample.  Previously the sample rate was fixed at 1 second. 
ddresses for Ethernet Communications 

• Fau
10 to match the E7, F7, G7, 

• Sto
 

r File Saving in CSV Format. 

ld 

 
 to F7 File Conversion Tool. 
This feature allows the user to convert a previously saved standard G5 drive parameter 
file into a standard F7 drive parameter file.   

• Parameter Down
This feature allows the user to download parameters to a drive without regard to the 
size or rating (KVA) or the drive control mode. This makes it possible to download a set 
of parameters for a unique app
drives that are either ope
e Feature on File Comparison 
A save button has been added to the File Comparison function to allow the user the 
ability to sav

• 
The ability to change the sampling time for graphi
been added to the graphing function.  The user can

• Ability to Store Multiple IP A
This feature allows the user to create a list of IP addresses to select a drive to go online 
with DriveWizard™  under Ethernet communications.  This is helpful when connecting 
to a network with a large number of drives. 
lt History Expanded to 10 Events to Match Drives. 

e has been expanded from 4 events to The Fault History featur
and P7 drives. 
p Button Added to Run Wizard Control Panel 
A stop button has been added to Run Wizard to make the control panel more user friendly.

• Expanded Paramete
When saving a parameter file in CSV format, you now get the parameter description, 
units, maximum value, minimum value, and factory default value.  Previously you wou
get the parameter number and value only. 
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DriveWizard™  5.5 Release October 2003 

to SI-E communications option. 
.  

 has been added to the communications set-up to allow DriveWizard™ to 
h a supported drive over 2 wire RS 485 network.  A RS 485 adapter for the PC 

o utilize this feature. 
• d Drive Support. 

nd G7 standard drives has been upgraded and minor database bugs 
dded to the standard database and V7 NEMA 4X databases have 

 
 

  
• Cre

ate a file 

• Parameter difference tab. 
. 

rom the factory 

 uto-tune support. 
DriveWizard™ will now support the auto-tune feature of E7, F7, and G7 drives.  The user can 
perform any of the available auto-tuning functions in the respective drive while online.  A 
convenient table will show key motor parameters before and after the auto-tuning sequence to 
enable the user to see which parameters where changed by the auto-tune. Status and fault displays 
keep the user informed of auto-tune progress and any errors occurring during the auto-tune. 

• Run Wizard. 
The Run Wizard function has three changes to it: 

1. The need for the Run Wizard password has been eliminated 
2. The user can now change speed and motor rotation direction while the drive is running. 
3. Run Wizard support for E7 has been added. 

• Communications Setup. 
DriveWizard™ will now support any available COM port available in Windows from COM port 
1 to COM port 99. This will allow users of Windows XP with USB only computers access to 
USB to serial port converters. 

• Print  Setup. 
DriveWizard™ will now allow you to select and set the properties for any installed printer in the 
Windows operating system. 

 

 
• Ethernet Communications 

This feature allows DriveWizard™  to connect via Ethernet  to a V7, E7, F7, G7 or P7 inverter
The connection is to the SI-E (CM090) communications option card only. All functions of  
DriveWizard™ are available except for the flash write feature in the factory mode. 

• RS 485 support 
Echo cancellation
communicate wit
is required t

Enhance
The support for E7, F7, a
repaired.  P7 support has been a
been added.  

DriveWizard™ Release 5.3 February 2003 

ate new parameter files. 
This feature allows DriveWizard™  to create a new parameter file from scratch instead of using 
pre-defined files or going online to the drive and saving the drive file. The user can cre
for any drive supported by the currently selected database. The user selects the drive family, 
model number (voltage and kW rating), and control mode.  The software then creates a complete 
parameter file for the selected inverter using factory default values. 

A new tab has been added to the DriveWizard™ parameter editor spreadsheet called “Difference”
This tab shows dynamically any parameters (online or offline) that are different f
default settings ( any parameter values in red or blue). The contents of the tab can also be printed. 

• A
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DriveWizard™ Release 5.0 July 2002: 
  
• Multiple Database design. 

This feature allows DriveWizard™ to connect to drives with special software’s.  The user can 
 fro  dat  a e ase  soft
ase t an ni g datab gram

• ons d soft upp r sta d™
, E
, F

A, G
N 
 HH
eri  G5. 

•  of
veW ve th tup f hin ill save ng to 
up t ime y nlin w ive. ed per pe. 

• par 7, F G7  n ang d onl
s pa ser t  a pr d /F custom V/F pattern.  
s pa geab  Dri W  . 

• s c or s have more information.  
• Mo ed t eria c nic  menu item.

rop o th com unications to allow DriveWizard™  to address a 
e if  on l co m ons ive requires a ss on 

 com rde veW z  co
t dri

• ate pro ess  atio eWizar ost 
con al a tain d Dr lp 

 
 

select
Datab

m the standard drive
s can be added by a

abase or
y time run

sp
n

cial datab
 a simple 

for the specific drive
ase installation pro

ware.  
. 

Additi  to the drives an ware s o ted as ndard in DriveWizar  : 
• E7A 7C, E7U 
• F7A 7C, F7U 
• G7 7C 
• V7
• G5 P modular drive 
• Gen c CASE support for
Saving  Graphing setup. 

Dri izard™ will now sa e last se  o the grap g function.  This w on havi
set his function every t ou go o e ith a dr  The settings are sav

rea
drive ty

E1-03 ameter for G5, E 7, and is ow ch eable, not just y. 
Thi rameter allows the u o select e- efined V  pattern or create a 
Thi rameter is now chan le from ve izard™

Modbu ommunication err window
Drive dbus Address add o the s l ommu ations setup  

A p erty has been added t e serial m
driv  more than 1 drive is the seria m unicati  port or the dr n addre
it’s munication port in o r for Dri i ard™  to nnect to  
tha ve. 

Integr d online help to im ve acc to inform n on using Driv d™  m
of the tents of this manu re con e  in the iveWizard™  He
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Appendix H: File Conversion Parameter Tables 
 
G5 to F7 and G5 to G7 Conversion Tool Parameter Table 

G5 
Param. Parameter Name F7/G7 

Param.  G5 
Param. Parameter Name F7/G7 

Param.
A1-00 Select Language A1-00  b1-05 Zero Speed Operation b1-05 
A1-02 Control Method A1-02  b1-06 Cntl Input Scans b1-06 
A1-03 Init Parameters A1-03  b1-07 LOC/REM RUN Sel b1-07 
A1-04 Enter Password A1-04  b1-08 RUN CMD at PRG b1-08 
A2-01 User Parameter 1 A2-01  b2-01 DCInj Start Freq b2-01 
A2-02 User Parameter 2 A2-02  b2-02 DCInj Current b2-02 
A2-03 User Parameter 3 A2-03  b2-03 DCInj Time @Start b2-03 
A2-04 User Parameter 4 A2-04  b2-04 DCInj Time @Stop b2-04 
A2-05 User Parameter 5 A2-05  b2-08 FieldComp b2-08 
A2-06 User Parameter 6 A2-06  b3-01 SpdSrch at Start b3-01 
A2-07 User Parameter 7 A2-07  b3-02 SpdSrch Current b3-02 
A2-08 User Parameter 8 A2-08  b3-03 SpdSrch Dec Time b3-03 
A2-09 User Parameter 9 A2-09  b4-01 Delay-ON Timer b4-01 
A2-10 User Parameter 10 A2-10  b4-02 Delay-OFF Timer b4-02 
A2-11 User Parameter 11 A2-11  b5-01 PID Mode b5-01 
A2-12 User Parameter 12 A2-12  b5-02 P Gain b5-02 
A2-13 User Parameter 13 A2-13  b5-03 PID I Time b5-03 
A2-14 User Parameter 14 A2-14  b5-04 PID I Limit b5-04 
A2-15 User Parameter 15 A2-15  b5-05 PID D Time b5-05 
A2-16 User Parameter 16 A2-16  b5-06 PID Limit b5-06 
A2-17 User Parameter 17 A2-17  b5-07 PID Offset b5-07 
A2-18 User Parameter 18 A2-18  b5-08 PID Delay Time b5-08 
A2-19 User Parameter 19 A2-19  b5-09 Output Level Sel b5-09 
A2-20 User Parameter 20 A2-20  b5-10 PID Output Gain b5-10 
A2-21 User Parameter 21 A2-21  b5-11 Output Rev Sel b5-11 
A2-22 User Parameter 22 A2-22  b5-12 Fb Los Det Sel b5-12 
A2-23 User Parameter 23 A2-23  b5-13 Fb Los Det Lvl b5-13 
A2-24 User Parameter 24 A2-24  b5-14 Fb Los Det Time b5-14 
A2-25 User Parameter 25 A2-25  b6-01 Dwell Ref @Start b6-01 
A2-26 User Parameter 26 A2-26  b6-02 Dwell Time @Start b6-02 
A2-27 User Parameter 27 A2-27  b6-03 Dwell Ref @Stop b6-03 
A2-28 User Parameter 28 A2-28  b6-04 Dwell Time @Stop b6-04 
A2-29 User Parameter 29 A2-29  b7-01 Droop Level b7-01 
A2-30 User Parameter 30 A2-30  b7-02 Droop Time Delay b7-02 
A2-31 User Parameter 31 A2-31  b8-01 Energy Saving Gain No Cnvt
A2-32 User Parameter 32 A2-32  b8-02 Energy Saving Freq. No Cnvt
    b8-03 Energy Save Mode b8-01 
b1-01 Reference Source b1-01  b8-04 Energy Save Gain b8-02 
b1-02 Run Source b1-02  b8-05 Energy Save FT b8-03 
b1-03 Stopping Method b1-03  b9-01 Zero Servo Gain b9-01 
b1-04 Reverse Oper b1-04  b9-02 Zero Servo Width b9-02 
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G5 

Param. Parameter Name F7/G7 
Param.  G5 

Param. Parameter Name F7/G7 
Param.

C1-01 Accel Time 1 C1-01  C8-30 Carrier in tune No Cnvt
C1-02 Decel Time 1 C1-02  d1-01 Reference 1 d1-01 
C1-03 Accel Time 2 C1-03  d1-02 Reference 2 d1-02 
C1-04 Decel Time 2 C1-04  d1-03 Reference 3 d1-03 
C1-05 Accel Time 3 C1-05  d1-04 Reference 4 d1-04 
C1-06 Decel Time 3 C1-06  d1-05 Reference 5 d1-05 
C1-07 Accel Time 4 C1-07  d1-06 Reference 6 d1-06 
C1-08 Decel Time 4 C1-08  d1-07 Reference 7 d1-07 
C1-09 Fast Stop Time C1-09  d1-08 Reference 8 d1-08 
C1-10 Acc/Dec Units C1-10  d1-09 Jog Reference d1-17 
C1-11 Acc/Dec SW Freq C1-11  d2-01 Ref Upper Limit d2-01 
C2-01 SCrv Acc  @ Start C2-01  d2-02 Ref Lower Limit d2-02 
C2-02 SCrv Acc @ End C2-02  d3-01 ump Freq 1 3-01 J d
C2-03 SCrv Dec @ Start C2-03  d3-02 Jump Freq 2 d3-02 
C2-04 SCrv Dec @ End C2-04  d3-03 Jump Freq 3 d3-03 
C3-01 Slip Comp Gain C3-01  d3-04 Jump Bandwidth d3-04 
C3-02 Slip Comp Time C3-02  d4-01 MOP Ref Memory d4-01 
C3-03 Slip Comp Limit C3-03  d4-02 Trim Control Lvl d4-02 
C3-04 Slip Comp Regen C3-04  d5-01 Torque Control Sel d5-01 
C3-05 Flux Select No Cnvt  d5-02 Torque Ref Delay d5-02 
C3-06 Output V Limit C3-05  d5-03 Speed Limit Sel d5-03 
C4-01 Torq Comp Gain C4-01  d5-04 Speed Limit  d5-04 
C4-02 Torq Comp Time C4-02  d5-05 Speed Limit Bias d5-05 
C4-03 F TorqComp @ start C4-03  d5-06 Speed/Torque Sw Time d5-06 
C4-04 R TorqComp @ start C4-04     
C4-05 TorqComp Delay T C4-05  E1-01 Input Voltage E1-01 
C5-01 ASR Gain 1 C5-01  E1-03 V/F Selection E1-03 
C5-02 ASR Time 1 C5-02  E1-04 Max Frequency E1-04 
C5-03 ASR Gain 2 C5-03  E1-05 Max Voltage E1-05 
C5-04 ASR Time 2 C5-04  E1-06 Base Frequency E1-06 
C5-05 ASR Limit C5-05  E1-07 Mid Frequency A E1-07 
C5-06 ASR Filter C5-06  E1-08 Mid Voltage A E1-08 
C5-07 ASR Switching Freq C5-07  E1-09 Min Frequency E1-09 
C5-08 ASR Integral Limit C5-08  E1-10 Min Voltage E1-10 
C6-01 Carrier Freq Max No Cnvt  E1-11 Mid Frequency B E1-11 
C6-02 Carrier Freq Min No Cnvt  E1-12 Mid Voltage B E1-12 
C6-03 Carrier Freq Gain No Cnvt  E1-13 Base Voltage E1-13 
C7-01 Hunting Prev Sel N1-01  E2-01 Motor Rated FLA E2-01 
C7-02 Hunting Prev Gain N1-02  E2-02 Motor Rated Slip E2-02 
C8-08 AFR Gain N2-01  E2-03 No-Load Current E2-03 
C8-09 AFR Time N2-02  E2-04 Number of Poles E2-04 
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G5 

Param. Parameter Name F7/G7 
Param.  G5 

Param. Parameter Name F7/G7 
Param.

E2-05 Term Resistance E2-05  F4-06 AO Ch2 Bias F4-06 
E2-06 Leak Inductance E2-06  F5-01 DO-02 Ch1 Select F5-01 
E2-07 Saturation Comp 1 E2-07  F5-02 DO-02 Ch2 Select F5-02 
E2-08 Saturation Comp 2 E2-08  F6-01 O-08 Selection 5-09 D F
E2-09 Motor Mech Loss E2-09  F7-01 PO-36F Selection No Cnvt
E2-10 orq Comp Iron Loss 2-10 T E  F8-01 E-15 Det Sel No Cnvt
E3-01 Control Method E3-01  F9-01 EFO Selection No Cnvt
E4-01 Max Frequency E3-02  F9-02 EFO Detection F6-02 
E4-02 Max Voltage E3-03  F9-03 EFO Fault Action F6-03 
E4-03 Base Frequency E3-04  F9-04 Trace Sample Time F6-04 
E4-04 Mid Frequency E3-05  F9-05 Torq Ref Limit Sel F6-06 
E4-05 Mid Voltage E3-06  F9-06 BUS Fault Sel F6-01 
E4-06 Min Frequency E3-07     
E4-07 Min Voltage E3-08  H1-01 Terminal 3 Sel H1-01 
E5-01 Motor Rated FLA E4-01  H1-02 Terminal 4 Sel H1-02 
E5-02 Motor Rated Slip E4-02  H1-03 Terminal 5 Sel H1-03 
E5-03 No-Load Current E4-03  H1-04 Terminal 6 Sel H1-04 
E5-04 Motor 2 No of Poles E4-04  H1-05 Terminal 7 Sel H1-05 
E5-05 Motor 2 term Ohms E4-05  H1-06 erminal 8 Sel 1-06 T H
E5-06 Motor 2 Leak E4-06  H2-01 erminal 9 Sel 2-01 T H
    H2-02 erminal 25 Sel 2-02 T H
F1-01 PG PPR  F1-01  H2-03 erminal 26 Sel 2-03 T H
F1-02 PG Open Sel F1-02  H3-01 erm 13 Signal 3-01 T H
F1-03 Overspeed Sel F1-03  H3-02 erm 13 Gain 3-02 T H
F1-04 Speed Dev Sel F1-04  H3-03 erm 13 Bias 3-03 T H
F1-05 PG Rotation F1-05  H3-04 erm 16 Signal 3-04 T H
F1-06 PG Div Rate F1-06  H3-05 erminal 16 Sel 3-05 T H
F1-07 Int Value Decel F1-07  H3-06 erminal 16 Gain 3-06 T H
F1-08 Overspeed Level F1-08  H3-07 erminal 16 Bias 3-07 T H
F1-09 Overspeed Time Dly F1-09  H3-08 erm 14 Signal 3-08 T H
F1-10 Ex Spd Dev Level F1-10  H3-09 erminal 14 Sel 3-09 T H
F1-11 Ex Spd Dev Time Dly F1-11  H3-10 erminal 14 Gain 3-10 T H
F1-12 PG Gear Teeth 1 F1-12  H3-11 erminal 14 Bias 3-11 T H
F1-13 PG Gear Teeth 2 F1-13  H3-12 ilter Avg Time 3-12 F H
F1-14 Pgo Dectect Time F1-14  H4-01 erminal 21 Sel 4-01 T H
F2-01 AI-14 Input Sel F2-01  H4-02 erminal 21 Gain 4-02 T H
F3-01 DI Input F3-01  H4-03 erminal 21 Bias 4-03 T H
F4-01 AO Ch1 Select F4-01  H4-04 erminal 23 Sel 4-04 T H
F4-02 AO Ch1 Gain F4-02  H4-05 erminal 23 Gain 4-05 T H
F4-03 AO Ch2 Select F4-03  H4-06 erminal 23 Bias 4-06 T H
F4-04 AO Ch2 Gain F4-04  H4-07 O Level Select 4-07 A H
F4-05 AO Ch1 Bias F4-05     
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G5 

Param. Parameter Name F7/G7 
Param.  G5 

Param. Parameter Name F7/G7 
Param.

H5-01 Serial Comm Adr H5-01  L8-10 Ground Fault Sel L8-09 
H5- H502 Serial Baud Rate -02  L8-17 Prtct@L - Spd No Cnvt
H5-03 Serial Com Sel H5-03  L8-19 OL2 Chara@L-Spd L8-15 
H5-04 Serial Fault Sel H5-04     
H5-05 Serial Flt Dtct H5-05  o1-01 U tor S  ser Moni el o1-01
    o1-02 P n Mo o1-02 ower- O nitor 
L1- lect 01 MOL Fault Se L1-01  o1-03 Display Scalin -03 g o1
L1- ime Const 02 MOL T L1-02  o1-04 D Units isplay o1-04 
L2-01 PwrL Selection L2-01  o1-05 Address Display No Cnvt
L2- ethru t 02 PwrL Rid L2-02  o2-01 L moteocal/Re  Key o2-01 
L2- ock t L2-03 03 PwrL Basebl  o2-02 Oper STOP key o2-02 
L2- F Ramp t -04 04 PwrL V/ L2  o2-03 User faults De o2-03 
L2- vel -05 05 PUV Det Le L2  o2-04 Inverter Model # o2-04 
L2-06 KEB Frequency L2-08  o2-05 O r M.O.perato P. o2-05 
L - cel Sel 3 01 StallP Ac L3-01  o2-06 Oper Detectio o2-06 n 
L3- Lvl 02 StallP Accel L3-02  o2-07 E ed Time o2-07 laps Set 
L3-03 StallP CHP Lvl L3-03  o2-08 E ed Time o2-08 laps Run 
L3- cel Sel 04 StallP De L3-04  o2-09 Init Mode Sel o2-09 
L3-05 StallP  Run Sel L3-05     
L3-   Run Level -06 06 StallP L3     
L4- e Level 01 Spd Agree L4-01     
L4-02 Spd Agree Width L4-02     
L4- ee Lvl + - 03 Spd Agr L4-03     
L4-04 Spd Agree Width + - L4-04     
L4- s Sel -05 05 Ref Los L4     
L5- estarts -01 01 Num of R L5     
L5- rt Sel 02 Resta L5-02     
L6- et 1 Sel 01 Torq D L6-01     
L6-02 Torq Det 1 Lvl L6-02     
L6- et 1 Time 03 Torq D L6-03     
L6- et 2 Sel 04 Torq D L6-04     
L6-05 Torq Det 2 Lvl L6-05     
L6- et 2 Time 06 Torq D L6-06     
L7- imit Fwd 01 Torq L L7-01     
L7-02 Torq Limit Rev L7-02     
L7- mt Fwd Rgn 03 Torq L L7-03     
L7-04 Torq Lmt Rev Rgn L7-04     
L8-01 DB Resistor Prot 01 L8-     
L8- larm Lvl 02 OH Pre-A L8-02     
L8- el 03 OH Pre-Alarm S L8-03     
L8-05 PH Loss In Sel L8-05     
L8- t Sel 07 PH Loss Ou L8-07     
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G  PD5  Conve Ta

Table 1: Parameter Conversion 

PD
 

505/P5 to E7 and G 05/P5 to P7 rsion bles 

P5 
Par. 

P5 Parameter Name Conversion E7/P7 
Par. 

 E7/P7 Parameter 
Name 

n001 Param selection/ init NVERTED NOT CO NA NA 
n002 Op Mode Select See Table 2 b1-01 & 

b1-02 
Run Seq Select 
Ref Select 

n003 Motor Rated Voltage n003/10 = E1-01 E1-01 Input Voltage 
n004 Stop Method If n004 > 1, then b1-03 =3, 

else n004 = b1-03 
b1-03 Stopping Method 

n005 Phase Rotation 
n006 Reverse Prohibited 

See Table 3 b1-04 Reverse operation 

n007 Local/Remote  None o2-01 Local / Remote Key 
n008 Stop Key Function o2-02 None  
n009 Freq Ref Setting from 

Digital Operator 
If n009=1, then o2-05=0, 
else o2-05 = 1 

o2-05 Freq Ref Setting Method 
Selection 

n010 V/F Pattern Select  NOT CONVERTED NA NA 
n011 Motor Rated Voltage  NOT CONVERTED NA NA 
n012 Max Frequency If n012 > 120.0 then E1-04 

=120.0, else n012 = E1-04 
E1-04 Max Output Freq. 

n013 Max voltage None E1-05 Output Voltage Max 
n014 Base Frequency If n014 > 200.0 then E1-06 

=200.0, else n014 = E1-06 
E1-06 Base Frequency 

 
n015 Mid Frequency If n015 > 200.0 then E1-07 

=200.0, else n015 = E1-07 
E1-07 Mid Frequency 

n016 Mid voltage None E1-08 oltage A Mid V
n017 Min Frequency None E1-09 Min Frequency 
n018 Min Voltage None E1-10 ltage Min Vo
n019 Accel Time 1 If n019 > 999.9, then 

n019*10 = C1-01, else n019 
= C1-01 

C1-01 Acceleration Time 1 

n020 Decel Time 1 If n020 > 999.9, then 
n020*10 = C1-02, else n020 
= C1-02 

C1-02 Deceleration Time 1 

n021 Accel Time 2 If n021 > 999.9, then n021 
*10 = C1-03, else n021 = 
C1-03 

C1-03 Acceleration Time 2 

n022 Decel Time 2 If n022 > 999.9, then 
n022*10 = C1-04, n022 = 
C1-04 

C1-04 Deceleration Time 2 

n023 S-curve select NOT CONVERTED NA NA 
n024 Operator Display Units If n024 >39 then n024*10 = 

o1-03, else n024 = o1-03 
o1-03 Digital Operator Display 

Selection 
n025 Freq Reference #1 n025*10 = d1-01 d1-01 Frequency Reference 1 
n026 Freq Reference #2 n026*10 = d1-02 d1-02 Frequency Reference 2 
n027 Freq Reference #3 n027*10 = d1-03 d1-03 Frequency Reference 3 
n028 Freq Reference #4 n028*10 = d1-04 d1-04 Frequency Reference 4 
n029 Jog Reference n029*10 = d1-17 d1-17 Jog Freq. reference 
n030 Freq Ref Upper Limit n030*10 = d2-01 d2-01 Freq Ref. Upper Limit 
n031 Freq Ref Lower Limit n031*10 = d2-02 d2-02 Freq. Ref. Lower Limit 
n032 Motor Rated Current None E2-01 Motor Rated Current 
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P5 
Par. 

P5 Parameter Name Conversion E7/P7 
Par. 

 E7/P7 Parameter 
Name 

n033 Motor OL Select If n033 > 1, then L1-01 = 1 L1-01 Mtr OL Protect Select 
n034 OH1 Stop Method None L8-03 OH Pre-Alarm Op Sel. 
n035 Terminal S2 Select If n035 >1, then table 4, else 

H1-03 = 0Fh 
H1-01 Terminal S3 Select 

n036 Terminal S3 Select Table 4 H1-02 Terminal S4 Select 
n037 Terminal S4 Select Table 4 H1-03 Terminal S5 Select 
n038 Terminal S5 Select Table 4 H1-04 Terminal S5 Select 
n039 Terminal S6 Select Table 4 H1-05 Terminal S5 Select 
n040 Terminal MA Select Table 5 H2-01 Terminal M1-M2 Sel. 
n041 Terminal M1 Select Table 5 H2-02 Terminal M3-M4 Sel. 
n042 Master Analog Input 

Sel. 
NOT CONVERTED NA NA 

n043 Terminal FI Select If n043 =1, then H3-08 =2, 
else H3-08 = 0 

H3-08 Terminal A2 Signal 
Level Select 

n044 Freq Ref Retention D NOT CONVERTE NA NA 
n045 Ref Loss Detect oss Det Sel None L4-05 Freq Ref L
n046 Freq Ref Gain n046*10 = H3-02 H3-02 Terminal A1 Gain 
n047 Freq Ref Bias n047*10 = H3-03 H3-03 Terminal A1 Bias 
n048 Terminal AM Sel Table 6 H4-01 Terminal FM Select 
n049 Terminal AM Gain n049*10 = H4-02 H4-02 Terminal FM Gain 
n050 Carrier Freq select NOT CONVERTED NA NA 
n051 Pwr Loss Ride Thru sel None L2-01 Pwr Loss Det Select 
n052 Spd Srch Current None b3-02 Spd srch Deact Current 
n053 Min Baseblock Time If n053 > 5.0 then L2-03 = 

5.0, else n053 = L2-03 
L2-03 Pwr Loss Min Base 

Block Time 
n054 Spd Search V/F NOT CONVERTED NA NA 
n055  Ride Thru Time None L2-02 Pwr Loss Ride-Thru 

 
 Pwr Loss

Time
n056 Number of Restarts None L5-01 f Restart attempts No.o
n057 Restart Select If n057 = 1 then L5-02 = 0, 

else L5-02 = 1 
L5-02 Auto Restart Operation 

Select 
n058 Jump Freq 1 If n058 > 200.0, then d3-01 

= 200.0, else n058 = d3-01 
d3-01 Jump Frequency 1 

n059 Jump Freq 2 If n059 > 200.0, then d3-02 
= 200.0, else n059 = d3-02 

d3-02 Jump Frequency 2 

n060 Jump Bandwidth If n060 > 20.0, then d3-04 = 
20.0, else n064 = d3-04 

d3-04 Jump Frequency Width 

n061 Elapsed Timer Select None o2-08 Cum. Op Time Select 
n062 Elapsed Time 1 NOT CONVERTED NA NA 
n063 Elapsed Time 2 NOT CONVERTED NA NA 
n064 DC inj Current None b2-02 nj Brkg Current DC I
n065 DC inj Time @ Stop n065*10 = b2-04 b2-04 DC INJ Time @Stop 
n066 DC inj Time @ Start n066*10 = b2-03 b2-03 DC INJ Time @ Start 
n067 Torq Comp Gain NOT CONVERTED NA NA 
n068 Mtr Line to Line Res. NOT CONVERTED NA NA 
n069 Mtr Iron Loss NOT CONVERTED NA NA 
n070 Stall Prev Decel None L3-04 Stall Prevent Sel. During  

l Dece
n071 Stall Prev. Accel Lvl NOT CONVERTED NA NA 
n072 NA Stall Prev Run Lvl NOT CONVERTED NA 
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P5 
Par. 

P5 Parameter Name Conversion E7/P7 
Par. 

E7/P7  Parameter 
Name 

n073 Freq Detection NOT CONVERTED NA NA 
n074 Torq Detect Select None L6-01 Torq Detect 1 select  
n0  Torq Detect Level None L6-02 Torq Detect 1 Level  75
n0  Torq Detect Time None L6-03 Torq Detect 1 Time 76
n0  Tim n Del None b4-01 Delay ON Timer 77 er O sy 
n0  Timer Off Del None b4-02 Delay OFF Timer 78 ay 
n0  DB Resistor Protect None L8-01 Internal DB Res. Prot. 79
n080 IN P oss L NOT CONVERTED NA NA h L vl 
n0  IN Ph Loss Dly time NOT CONVERTED NA NA 81
n0  Out Ph Loss Lvl NOT CONVERTED NA NA 82
n0  IN P oss D e NOT CONVERTED NA NA 83 h L ly Tim
n084 PID Mode Sel If n084 >0, then B5-01 = 1, 

else B5-01 = 0 
b5-01 PID Mode Sel 

n085 PID Fdbk Gain NOT CONVERTED NA NA 
n086 PID P gain n086*10 = b5-02 b5-02 Proportional Gain Set 
n087 PID I Time None B5-03 PI I Time 
n088 PID D Time NOT CONVERTED NA NA  
n089 PID Offset N089*10 = b5-07 b5-07 PI Offset Set 
n0  90 PID I Limit n090*10 = b5-04 b5-04 Integral Limit  Set 
n091 Output Lag Filter n091*10 = b5-08 B5-08 PI Pri. Lag filter 
n0  PID Fdbk Loss Select None b5-12 Fb Loss Detect Select 92
n093 PID Fdbk Loss Lvl None b5-13 Fb Loss Detect Level 
n094 PID Fbbk Loss T b Loss Detect Time ime None b5-14 F
n095 Energy Save Se nergy Saving Select l None b8-01 E
n096 Energ  N VE  Ny Saving gain K2 OT CON RTED NA A 
n097 Energy Save Vlim 

@
NOT CONVERTED NA NA 

60hz 
n0 En hz NO NV NA 98 ergy Save Vlim@6 T CO ERTED NA 
n0 En gkW NO NV NA NA 99 ergySVTime Av T CO ERTED 
n1 En une NOT NV NA NA 00 ergy Save Vlim T  CO ERTED 
n1 En

10
NO NV NA NA 01 ergy Save Step V 

0% 
T CO ERTED 

n1 En  NO NV NA 02 ergy Save Step V 5% T CO ERTED NA 
n1 M Non H5-05 Serial Flt Detect 03 ODBUS Timeout e 
n1 M Non H5-04 Serial Flt Select 04 ODBUS Fault Stop e 
n1 MODBUS Ref Unit NO NV NA NA 05 T CO ERTED 
n106 MODBUS Address n10 v t4 con o hex = H5-01 H5-01 Serial Comm Adr 
n107 MODBUS Baud Rate n10 = H5 +1 5-02 H5-02 Serial Baud Rate 
n1 MODBUS Parity Non H5-03 Serial Comm Select 08 e  
n1 Sl NO NV NA NA 09 ip Comp Gain T CO ERTED 
n1 M NO NV NA NA 10 tr No-load Current T CO ERTED 
n1 Sl NO NV NA NA 11 ip Comp Delay T CO ERTED 
n1 O None o2-06 Oper Detection 12 perator Detect Flt  
n1 Freq Agree Det Width NOT CONVERTED NA NA 13 
n1 Loc/REM Change Non b1-07 Local / Remote Run 14 e 

Selection 
n1 In No o2-04 Inverter Model # 15 verter KVA Select ne  
n1 Ct/VT Select NO NV NA 16 T CO ERTED NA 
n1 Lo L2 Start NO NV NA 17 w Freq O T CO ERTED NA 
n118 OL2 Level @ 0 hz NOT CONVERTED NA NA 
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Table 2: n0
to b1- 01 & 02 

02 decode  

n002 b1-01 b1-02 
0 0 0 
1 0 1 
2 1 0 
3 1 1 
4 2 0 
5 2 1 
6 2 2 
7 0 2 
8 1 2 

 
 
Table 3: n005 and n006  
de deco  to b1- 04 
n005 n006 b1-04 

0 0 0 
0 1 1 
1 0 2 
1 1 3 

 
 

Table 4: Multi-Function Contact Input Select  
P5 

Setting 
P5 Description E7/P7 

Setting
E7/P7 Description Comment 

2 Ext. Fault NO 24h Ext Flt NO Allways Det  
3 External Fault NC 25h Ext Flt NO Allways Det  
4 Fault Reset 14h Fault Reset  
5 LOC/REM Select 1h Local/ Remote Sel  
6 Comm/Term Control Sw. 6Bh Com/Inv Sel  
7 ESTOP NO 15h Fast Stop NO  
8 FV/FI Term Switch 0Fh Not Used No Function in E7/P7 
9 Multi-step Spd  set 1 03h Multi-Step Ref 1  

10 Multi-step Spd set 2 04h Multi-Step Ref 2  
11 Jog Freq Select 06h Jog Freq Ref  
12 Accel/Decel Time Switch 07h Multi- Accel/Dece; 1  
13 Ext BB NO 08h Ext BB NO  
14 Ext BB NC 09h Ext BB NC  
15 Spd Srch from Max Freq 61h Speed Search 1  
16 Spd Srch from set Freq 62h Speed Search 2  
17 Param Write enable 1Bh Program Lockout  
18 PID Int Value reset 30h PI Int Reset  
19 PID Control disable 19h PI Disable  
20 Timer Start 18h Timer Function  
21 Inv Overheat OH3 0Fh Not Used No Function in E7/P7 
22 Sample/Hold analog Ref 1Eh Ref Sample Hold  
23 KEB NO 0Fh Not Used No Function in E7/P7 
24 KEB NC 0Fh Not Used No Function in E7/P7 
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Table 5: Multi-Function Contact Output Select. 
P5 

Setting 
P5 Description E7/P7 

Setting
E7/P7 Description Comment 

0  Fault  0Eh Fault  
1 D 00  uring Run h During Run  
2 Frequency Agree 02h Fref/Fout Agree 1  
3 @ Set Freq Agree 03h Fref/Set Agree 1  
4 Freq Detect. 1 04h Freq Detect 1  
5 Freq Detect 2 05h Freq Detect 2  
6 Overtorque Detect NO ect 1 NO  0Bh Trq Det
7 Overtorque Detect NC C   17h Trq Detect 1 N
8 Base Blocked   08h Base Block 1
9 Operation Mode eration Refere  09h Op nce 

10 Inverter Ready 06h Inverter Ready  
11  Timer Output  Timer Output 12h 
12 Auto Restarting 1Eh Restart Enabled  
13 OL Pre-Alarm 1Fh Overload (OL1)  
14 of Ref  Freq Ref Loss 0Ch Loss 
15 Comm Run CMD om/opt  3Bh Run Src C  
16 PID Fdbk Loss No F0Fh Not Used unction in E7/P7 
17 OH1 Alarm   20h OH Pre Alarm

 

Table 6: Mutli-Function Analog Output Selection 

 
 

n048 H4-01 
0 2 
1 3 
2 8 
3 7 
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GPD 50 d GPD  P7 C sion Tables 
 

Table 1: Parameter conversion

6/P5+ to E7 an 506/P5+ to onver

 
P5+ 
Par. 

P5+ Parameter 
Name 

Conversion E7/P7 
Par. 

 E7/P7 Parameter 
Name 

n001 it Param selection/ in NOT CONVERTED NA NA 
n002 Op Mode Select See Table 2 b1-01 & 

b1-02 
Run Seq Select 
Ref Select 

n003 Motor Rated Voltage n003/10 = E1-01 E1-01 Input Voltage 
n004 Stop Method If n004 > 1, then b1-03 

=3, else n004 = b1-03 
b1-03 Stopping Method 

n005 Phase Rotation 
n006 Reverse Prohibited 

See Table 3 b1-04 Reverse operation 

n007 Local/Remote  None o2-01 l / Remote Key Loca
n008 Stop Key Function None o2-02  
n009 Freq Ref Setting from 

Digital Operator 
If n009=1, then o2-05=0, 
else o2-05 = 1 

o2-05 Freq Ref Setting Method 
Selection 

n010 V/F Pattern Select ONVERTED NA NOT C NA 
n011 Max Frequency If n011 > 120.0 then E1-

04 =120.0, else n011 = 
E1-04 

E1-04 Max Output Freq. 

n012 Max voltage None E1-05 Max Output Voltage 
n013 Base Frequency If n013 > 200.0 then E1-

06 =200.0, else n013 = 
E1-06 

E1-06 Base Frequency 
 

n014 Mid Frequency If n014 > 200.0 then E1-
07 =200.0, else n014 = 
E1-07 

E1-07 Mid Frequency 

n015 Mid voltage None E1-08 Mid Voltage A 
n016 Min Frequency None E1-09 Min Frequency 
n017 Min VMin Voltage None E1-10 oltage 
n018 Accel Time 1 If n018 > 999.9, then 

n018*10 = C1-01, else 
n018 = C1-01 

C1-01 Acceleration Time 1 

n019 Decel Time 1 If n019 > 999.9, then 
n018*10 = C1-02, else 
n019 = C1-02 

C1-02 Deceleration Time 1 

n020 Accel Time 2 n020 *10 = C1-03 C1-03 Acceleration Time 2 
n021 Decel Time 2 n021*10 = C1-04 C1-04 Deceleration Time 2 
n022 S-curve select NOT CONVERTED NA NA 
n023 Operator Display Units If n023 >39 then n023*10 

= o1-03, else n023 = o1-
03 

o1-03 Digital Operator Display 
Selection 

n024 Freq Reference #1 n025*10 = d1-01 d1-01 Frequency Reference 1 
n025 Freq Reference #2 n026*10 = d1-02 d1-02 Frequency Reference 2 
n026 Freq Reference #3 n027*10 = d1-03 d1-03 Frequency Reference 3 
n027 Freq Reference #4 n028*10 = d1-04 d1-04 Frequency Reference 4 
n028 D Freq Reference #5 NOT CONVERTE NA NA 
n029 Freq Reference #6 NOT CONVERTED NA NA 
n030 Jog Reference n030*10 = d1-17 d1-17 Jog Freq. reference 
n031 Freq Ref Upper Limit n031*10 = d2-01 d2-01 Freq Ref. Upper Limit 
n032 Freq Ref Lower Limit n032*10 = d2-02 d2-02 Freq. Ref. Lower Limit 
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P5+ 
Par. 

P5+ Parameter 
Name 

Conversion E7/P7 
Par. 

 E7/P7 Parameter 
Name 

n033 Motor Rated Current None E2-01 r Rated Current Moto
n034 Motor OL Select If n033 > 1, then L1-01 = 

1 
L1-01 Mtr OL Protect Select 

n035 OH1 Stop Method 3 re-Alarm Op Sel. None L8-0 OH P
n036 Terminal S2 Select If n036 >1, then table 4, 

else H1-03 = 0Fh 
H1-01 Terminal S3 Select 

n037 Terminal S3 Select Table 4 H1-02 Terminal S4 Select 
n038 Terminal S4 Select Table 4 H1-03 Terminal S5 Select 
n039 Terminal S5 Select Table 4 H1-04 Terminal S6 Select 
n040 Terminal S6 Select Table 4 H1-05 Terminal S7 Select 
n041 Terminal MA Select Table 5 H2-01 Terminal M1-M2 Sel. 
n042 Terminal M1 Select Table 5 H2-02 Terminal M3-M4 Sel. 
n043 Analog Input Select D NA NA NOT CONVERTE
n044 Terminal FI Select If n044 =1, then H3-08 

=2, else H3-08 = 0 
H3-08 Terminal A2 Signal Level 

Select 
n045 MOP Ref Memory ONVERTED NOT C NA NA 
n046 Ref Loss Detect 5  Ref Loss Det Sel None L4-0 Freq
n047 Freq Lvl @ F Ref Loss n047*10 = L4-06 L4-06 Freq Ref Lvl@loss  
n048 Terminal FV Gain n048*10 = H3-02 H3-02 Terminal A1 Gain 
n049 Terminal FV Bias n049*10 = H3-03 H3-03 Terminal A1 Bias 
n050 Terminal FI Gain n050*10 = H3-10 H3-10 Terminal A2 Gain 
n051 Terminal FI Bias n051*10 = H3-11 H3-11 Terminal A2 Bias 
n052 Terminal AM Sel Table 6 H4-01 Terminal FM Select 
n053 Terminal AM Gain n053*10 = H4-02 H4-02 Terminal FM Gain 
n054 Carrier Freq select ONVERTED NA NA NOT C
n055 Pwr Loss Ride Thru sel None L2-01 t Select Pwr Loss De
n056 t Spd Srch Current None b3-02 Spd srch Deact Curren
n057 Min Baseblock Time If n057 > 5.0 then L2-03 = 

5.0, else n057 = L2-03 
L2-03 Pwr Loss Min Base Block 

Time 
n058 rch V/F NOT CONVERTED NA NA Spd Sea
n059 Pwr Loss Ride Thru Time None L2-02 Loss Ride-Thru TimePwr 
n060 Number of Restarts None L5-01 f Restart attempts No.o
n061 Restart Select If n061 = 1 then L5-02 = 

0, else L5-02 = 1 
L5-02 Auto Restart Operation 

Select 
n062 Jump Freq 1 If n062 > 200.0, then d3-

01 = 200.0, else n062 = 
d3-01 

d3-01 Jump Frequency 1 

n063 Jump Freq 2 If n063 > 200.0, then d3-
02 = 200.0, else n063 = 
d3-02 

d3-02 Jump Frequency 2 

n064 Jump Bandwidth If n064 > 20.0, then d3-04 
= 20.0, else n064 = d3-04 

d3-04 Jump Frequency Width 

n065 Elapsed Timer Select t None o2-08 Cum. Op Time Selec
n066 Elapsed Time 1 NOT CONVERTED NA NA 
n067 Elapsed Time 2 NOT CONVERTED NA NA 
n068 DC inj Current None b2-02 nj Brkg Current DC I
n069 DC inj Time @ Stop n069*10 = b2-04 b2-04 DC INJ Time @Stop 
n070 DC inj Time @ Start n070*10 = b2-03 b2-03 DC INJ Time @ Start 
n071 NA Torq Comp Gain NOT CONVERTED NA 
n072 Stall Prev Sel. on  Decel Stall Prev Decel None L3-04 
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P5+ 
Par. 

P5+ Parameter 
Name 

Conversion E7/P7 
Par. 

 E7/P7 Parameter 
Name 

n073 Stall Prev. Accel Lvl N NA NOT CONVERTED A 
n074 Stall Prev l NOT CONVERTED NA NA  Run Lv
n075 Freq Det L NOT CONVERTED NA NA evel 
n0  Freq Det Width NOT CONVERTED NA NA 76
n0  Torq Detect Select None L6-01 Torq Detect 1 select  77
n0  Torq Detect Level None L6-02 Torq Detect 1 Level  78
n0  Torq Detect Time None L6-03 Torq Detect 1 Time 79
n0  Timer On Delsy None b4-01 Delay ON Timer 80
n0  Timer Off Delay None b4-02 Delay OFF Timer 81
n0  DB Resistor Protect None L8-01 Internal DB Res. Prot. 82
n0  IN Ph Loss Lvl NOT CONVERTED NA NA 83
n0  84 PID Mode Sel If n084 >0, then b5-01 = 

1, else b5-01 = 0 
b5-01 PID Mode Sel 

n085 PID Fdbk Gain NOT CONVERTED NA NA 
n086 PID P gain n086*10 = b5-02 b5-02 Proportional Gain Set 
n087 PID I Ti None PI I Time me B5-03 
n0 PI NOT C RTE A88 D D Time D NA N  ONVE
n089 PID I Limit n089*10 = b5-04 b5-04 Int ral Limit Set eg
n0 PID Fdbk Loss Select None -12 Fb Loss Detect Select 90 b5
n091 PI None Fb Loss Detect Level D Fdbk Loss Lvl b5-13 
n0 PI None 14 Fb Loss Detect Time 92 D Fbbk Loss Time b5-
n0 PID Output Select None 9 Output Level Select 93 b5-0
n094 Sleep Start Lvl If n094 .0, th > 200 en b5-

15 = 20 lse n0.0, e 094 = 
b5-15 

b5-15 Sleep Level 

n0 Sl None Sleep Time 95 eep Delay Time b5-16 
n0 En None En96 ergy Save Sel b8-01 ergy Saving Select 
n0 En NOT C RTE NA97 ergy Save Gain ONVE D NA  
n0 En

@
NOT C RTE NA98 ergy Save Vlim 

60hz 
ONVE D NA  

n0 En lim@6hz NOT C RTE A NA99 ergy Save V ONVE D N  
n100 EnergySVTime AvgkW NOT CONVERTED NA NA  
n1 M None Serial Flt Detect 01 ODBUS Timeout H5-05 
n102 M None Serial Flt Select ODBUS Fault Stop H5-04 
n1 M NOT CONVERTE NA03 ODBUS Ref Unit D NA  
n104 MODBUS Address n104 c  hex onv to = H5-01 H5-01 Serial Comm Adr 
n105 MODBUS Baud Rate n105 +1 = H5-02 H5-02 Serial Baud Rate 
n1 M None Se06 ODBUS Parity H5-03 rial Comm Select 
n1 Sl NOT CONVERTE NA07 ip Comp Gain D NA  
n1 Mtr No-load Current NOT C RTE NA08 ONVE D NA  
n1 Sl elay NOT C RTE NA09 ip Comp D ONVE D NA  
n1 O None Op10 perator Detect Flt o2-06 er Detection 
n1 Lo one Local / Remote Run 

Se
11 c/REM Change N b1-07 

lection 
n1 Lo NOT CO ERTE NA12 w Freq OL2 Start NV D NA  
n113 OL2 Level @ 0 hz NOT CONVERTED NA NA 
n114 Sqr Root Gain NOT CONVERTED NA NA 
n115 Inverter KVA Select None o2-04 Inverter Model # 
n116 Ct/VT Select NOT CONVERTED NA NA 
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T  2: n0    Table 3: n005 and n006   

 to b1- 01 & 02      to b1- 04   
 
 

  
  

  
  

ble 4: M u t Inpu Select 

able
decode

02 decode   

 
  
  
  

  

Ta ulti-F nction Contac t 
P5 

Setting 
P5 Description E7 Setting E7 Descriptio  n Comment 

2 Ext. Fault NO 24 Allwayh Ext Flt NO s Det  
3 External Fault NC 5h O Allway2  Ext Flt N s Det  
4 Fault Reset 14h set   Fault Re
5 LOC/REM Select 1h Local/ Remote Sel  
6 Comm/Term Control Sw. 6Bh Com/Inv Sel  
7 ESTOP NO 15h Fast Stop NO  
8 ESTOP NC 17h Fast Stop NC  
9 FV/FI Term Switch 0Fh Not Used No Function in E7/P7 

10 Multi-step Spd  set 1 03h Multi-Step Ref 1  
11 Multi-step Spd set 2 04h Multi-Step Ref 2  
12 Multi-step Spd set 3 0Fh Not Used No Function in E7/P7 
13 Jog Freq Select 06h Jog Freq Ref  
14 Accel/Decel Time Switch 07h Multi- Accel/Dece; 1  
15 Ext BB NO 08h Ext BB NO  
16 Ext BB NC 09h Ext BB NC  
17 Spd Srch from Max Freq 61h Speed Search 1  
18 Spd Srch from set Freq 62h Speed Search 2  
19 Param Write enable 1Bh Program Lockout  
20 PID Int Value reset 30h PI Int Reset  
21 PID Control disable 19h PI Disable  
22 Timer Start 18h Timer Function  
23 Inv Overheat OH3 0Fh Not Used No Function in E7/P7 
24 Sample/Hold analog Ref 1Eh Ref Sample Hold  
25 KEB NO 0Fh Not Used No Function in E7/P7 
26 KEB NC 0Fh Not Used No Function in E7/P7 
27 Decel/Accel Prohibit 0Ah Acc/Dec Ramp Hold  
28 PID Input charact. change 35h PI Input Level Sel  

10 MOP Increase H1-04 Only 29 Up/Down (n040 only) 
11 MOP Decrease H1-05 Only 

 

n005 n006 b1-04 
0 0 0 
0 1 1 
1 0 2 
1 1 3 

n002 b1-
01 

b1-
02 

0 0 0 
1 0 1 
2 1 0 
3 1 1 
4 2 0 
5 2 1 
6 2 2 
7 0 2 
8 1 2 
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Table 5: Multi-Function Contact Output Select. 
P5 

Setting 
P5 Description E7 

Setting
E7 Description Comment 

0  Fault  0Eh Fault  
1 During Run 00h During Run  
2 Frequency Agree 02h Fref/Fout Agree 1  
3 @ Set Freq Agree 03h Fref/Set Agree 1  
4 Freq Detect. 1 04h Freq Dete  ct 1 
5 ect 2 05h F te  Freq Det req De ct 2 
6 ue Detect NO 0Bh T ctOvertorq rq Dete  1 NO  
7 Overtorque Detect NC Tr tect   17h q De  1 NC 
8 B oc h B lock  ase Bl ked 08 ase B 1 
9 O n Operation Reference peratio  Mode 09h  

10 Inverter Ready 06h In  Reaverter dy  
11 ut Timer Output Timer O put 12h  
12 R  Ena  Auto Restarting 1Eh estart bled 
13 Al  O d (O  OL Pre- arm 1Fh verloa L1) 
14 f L 0Ch Loss of Ref  Freq Re oss 
15 u Run Src Com/opt  Comm R n CMD 3Bh 
16 k Fh Not Used No nct n in /P7PID Fdb  Loss 0 Fu io  E7  
17 rm OH Pre Alarm  OH1 Ala  20h 

 
 
 
Table 6: F log Outpu ecti Mutli- unction Ana t Sel on 
n052 H4-01 

0 2 
1 3 
2 8 
3 7 
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Appendix J: KVA & Control Mode Parameters  
 

The followin s in the g tables detail the KVA and control mode dependent parameter
drives ght  bot  trol M  .  Highli ed parameters  are h KVA and Con ode dependent.

 
G5, E7, F7, G7,  & P7 KVA Dependent Parameters 

Applicable Drive 
Param. Parameter Name KVA 

Depd 
Control 
Mode 
Depd G5 E7 F7 G7 P7 

b8-02 Energy Save Gain Yes No   ● ●  
b8-03 Energy Save F.T Yes Yes ●   1  ● ●  
b8-04 Energy Save Coeff Yes Yes ● 1 ● ● ● ● 
C4-02 Torq Comp Time Yes Yes ● 1 ● ● ● ● 
C6-01 Carrier Freq Yes Yes ●     
C6-01 Heavy/Normal Duty Yes No   ●   
C6-02 Carrier Freq Sel Yes No   ● ●  
C6-02 Carrier Freq Min Yes Yes ●     
C6-03 Carrier Freq Gain Yes Yes ●     
C6-03 Carrier Freq Max Yes Yes    ●  
C6-04 Carrier Freq Min Yes Yes    ●  
C6-05 Carrier Freq Gain Yes Yes    ●  
C6-11 Carrier Freq Sel Yes No    ●  
D3-01 Jump Freq 1 Yes No     ●     
D3-02 Jump Freq 2 Yes No     ●     
D3-03 Jump Freq 3 Yes No     ●     
E1-01 Input Voltage Yes No ● ● ● ● ● 
E1-04 Max Frequency Yes Yes ● ● ● ● ● 
E1-05 Max Voltage Yes No ● ● ● ● ● 
E1-06 Base Frequency Yes Yes ● ● ● ● ● 
E1-07 Mid Frequency A Yes Yes ● ● ● ● ● 
E1-08 Mid Voltage A Yes Yes ● ● ● ● ● 
E1-09 Min Frequency Yes Yes ● ● ● ● ● 
E1-10 Min Voltage Yes Yes ● ● ● ● ● 
E1-11 Mid Freq B Yes No ● ● ● ● ● 
E1-12 Mid Voltage B Yes No ● ● ● ● ● 
E1-13 Base Voltage Yes No ● ● ● ● ● 
E2-01 Motor Rated FLA Yes No ● ● ● ● ● 
E2-02 Motor Rated Slip Yes No ● ● ● ● ● 
E2-03 No-Load Current Yes No ● ● ● ● ● 
E2-05 Term Resistance Yes No ● ● ● ● ● 
E2-06 Leak Inductance Yes No ● ● ● ● ● 
E2-10 Torq Comp Iron L Yes No ● ● ● ● ● 
E2-11 Motor Rated Powr Yes No  ● ● ● ● 
E3-03 Mtr 2 Max Volt Yes No   ● ●  
E3-04 Mtr 2 Base Freq Yes No   ● ●  
E3-06 Mtr 2 Mid Volt Yes No   ● ●  
E3-08 Mtr 2 Min Volt Yes No   ● ●  

Notes:  1. G5 is control mode depend only. 
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G5, E7, F7, G7,  & P7 KVA Dependent Parameters 

Applicable Drive 
Param. Parameter Name KVA 

Depd 
Control 
Mode 
Depd G5 E7 F7 G7 P7 

E4-01 Mtr 2 Rated A Yes ● ● No    
E4-02 Mtr 2 Max Volt Yes No ●     
E4-02 Mtr 2 Rated Slip Yes No   ● ●  
E4-03 Mtr 2 No Load A Yes No   ● ●  
E4-05 Mtr 2 Mid Volt Yes No ●     
E4-05 Mtr 2 Term Resist Yes No   ● ●  
E4-06 Mtr 2 Leak Ind Yes No   ● ●  
E4-07 Mtr 2 Min Volt Yes No ●     
E4-07 Mtr 2 Rated Power Yes No   ● ●  
E5-01 Mtr 2 Rated A Yes No ●     
E5-02 Mtr 2 Rated Slip Yes No ●  ●   
E5-03 Mtr 2 No Load A Yes No ●  ● ●  
E5-05 Mtr 2 Term Resist Yes No ●     
E5-06 Mtr 2 Leak Ind Yes No ●     
L2-02 PwrL Ridethru t Yes No ● ● ● ● ● 
L2-03 PwrL Baseblock t Yes No ● ● ● ● ● 
L2-04 PwrL V/F Ramp t Yes No ● ● ● ● ● 
L2-05 PUV Det Level Yes No ● ● ● ● ● 
L3-12 OV Inhib Volt Level Yes No   ● ●  
L4-01 Spd Agree Level Yes No   ●   
L4-03 Spd Agree Level +/- Yes No   ●   
L8-02 OH Pre-Alarm Level Yes No ● ● ● ● ● 
L8-04 OH1 Fault Level Yes No ● ● ● ● ● 
L8-06 PH Loss Level Yes No  ● ● ● ● 
N1-03 Hunt Prev Time Yes No ● ● ● ● ● 
N4-40 I Stab. Coeff Low Spd Yes No    ●  
N5-02 Motor Accel Time Yes No   ● ●  
T1-01 Tuning Mode Sel Yes No   ●   
T1-02 Mtr Rated Power Yes No  ● ● ● ● 
T1-03 Mtr Rated Voltage Yes No   ● ●  
T1-04 Mtr Rated Current Yes No  ● ● ● ● 
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G5, E7, F7, G7,  & P7 Control Mode Dependent 
Parameters 

Ap ve plicable Dri
Param. Parameter Name KVA 

Depd 
Control 
Mode 
Depd G5 E7 F7 G7 P7 

b1-03 ng No   ●  Stoppi  Method Yes   
b3-01 ch No s ● ● ● ● SpdSr  at Start Ye ● 
b3-02 ch No Yes ● ● ● ● SpdSr  Current ● 
b6-01 Re No   ●   Dwell f @ Start Yes  
b6-03  Re No   ●   Dwell f @ Stop Yes  
b8-05 Energy Save Time No      Yes ● 
C3-01 om No   ● ●  Slip C p Gain Yes ● 
C3-02 om No   ● ●  Slip C p Time Yes ● 
C3-05  C No    ●  V/f Slip omp Sel Yes  
C5-01 a No   ● ●  ASR G in 1 Yes ● 
C5-02 im No   ● ●  ASR T e 1 Yes ● 
C5-03 a No   ● ●  ASR G in 2 Yes ● 
C5-04 im No   ● ●  ASR T e 2 Yes ● 
C5-05 ASR im No Yes  ● ●  L it ● 
C5-06 ASR ilt No s  ● ●  F er Ye ● 
C5-07 wi No   ●   ASR S tch Freq Yes  
d5-02  R No   ● ●  Torque ef Delay Yes  
E4-09  AS No    ●  Mtr 2 R  P Gain Yes  
E4-10 AS No    ●  Mtr 2 R I Time Yes  
F1-09 vrs No   ● ●  PG O pd Time Yes ● 
N5-01 or No  ● ●  FeedF ward Sel Yes   
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GPD31 PD305/J7 K5/V7, G VA & Control Mode 
Dependent Parameters 

Applicable 
Drive Param. Parameter Name KVA 

Depd 
Control 
Mode 
Depd J7 V7 

N012 Max Voltage Yes No  ● 
N014 Mid Freq No Yes  ● 
N015 Mid voltage Yes Yes  ● 
N016 Min Freq No Yes  ● 
N017 Min Voltage Yes Yes  ● 
N036 Mtr Rated Current  ● Yes No 
N080 Carrier Freq Sel Yes No  ● 
N104 Torq Comp Time  ● No Yes 
N105 Motor Iron Loss Yes No  ● 
N106 Motor Rated Slip Yes No  ● 
N107 Motor Term Res Yes No  ● 
N108 Motor Leak Ind Yes No  ● 
N110 Motor No Load A Yes No  ● 
N111 Slip Comp Gain No Yes  ● 
N112 Slip Comp Time No Yes  ● 
N184 Hunting Prev Gain Yes No  ● 
N10 Max Voltage Yes No ●  
N13 Mid Voltage Yes No ●  
N15 Min Voltage Yes No ●  
N46 Carrier Freq Sel Yes No ●  
N64 Motor Rated Slip Yes No ●  
N65 Motor No Load A Yes No ●  
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YASKAWA ELECTRIC AMERICA, INC. 
Drives Division 
16555 W Ryerson Rd, New Berlin, WI. 53151, USA 
Phone (800) YASKAWA (800-927-5292)  
Fax 1-262-782-3418 
HTInternet: http://www.drives.com TH 

 
YASKAWA ELECTRIC AMERICA, INC. 
Chicago-Corporate Headquarters 
2121 Norman Drive South, Waukegan, IL 60085, U.S.A. 
Phone (800) YASKAWA (800-927-5292) 
 Fax 1-847-887-7370 
HTInternet: http://www.yaskawa.com TH 

 
MOTOMAN INC. HEADQUARTERS 
805 Liberty Lane West Carrollton, OH 45449, U.S.A. 
Phone 1-937-847-6200 Fax 1-937-847-6277 
HTInternet: http://www.motoman.com TH 

 
YASKAWA ELECTRIC CORPORATION 
New Pier Takeshiba South Tower, 1-16-1, Kiagan 
Minatoku,Tokyo, 105-0022, Japan 
Phone: 81-3-5402-4511   Fax: 81-3-5402-4580 
TInternet: T HThttp://www.yaskawa.co.jp TH 

 
YASKAWA ELÉTRICO DO BRASIL COMÉRCIO LTDA. 
Avenida Fagundes Filho, 620 Bairro Saude-Sao Pãulo-SP, 
Brazil CEP: 04304-000 
Phone 55-11-5071-2552 Fax 55-11-5581-8795 
THInternet: http://www.yaskawa.com H.br 
 
YASKAWA ELECTRIC EUROPE GmbH 
Am Kronberger Hang 2, 65824 Schwalbach, Germany 
Phone 49-6196-569-300 Fax 49-6196-888-301 
HInternet: http://www.yaskawa.de H 

 
Motoman Robotics AB 
Box 504 S38525 Torsås, Sweden 
Phone 46-486-48800 Fax 46-486-41410 
 
Motoman Robotec GmbH 
Kammerfeldstraβe 1, 85391 Allershausen, Germany 
Phone 49-8166-900 Fax 49-8166-9039 
 
YASKAWA ELECTRIC UK LTD. 
1 Hunt Hill Orchardton Woods Cumbernauld, G68 9LF, 
United Kingdom 
Phone 44-12-3673-5000 Fax 44-12-3645-8182 
 
 
 

YASKAWA ELECTRIC KOREA CORPORATION 
Paik Nam Bldg 901 188-3,1-Ga Eujiro, Joong-Gu, 
 Seoul 150-010, Korea 
Phone 82-2-784-7844 Fax 82-2-753-2639 
 
YASKAWA ELECTRIC (SINGAPORE) PTE. LTD. 
Head Office: 151 Lorong Chuan, #04-01, New Tech Park 
Singapore 556741, Singapore 
Phone 65-282-3003 Fax 65-289-3003 
 
TAIPEI OFFICE (AND YATEC ENGINEERING 
CORPORATION) 
 10F 146 Sung Chiang Road, Taipei, Taiwan 
Phone 886-2-2563-0010 Fax 886-2-2567-4677 
 
YASKAWA JASON (HK) COMPANY LIMITED 
Rm. 2909-10, Hong Kong Plaza, 186-191 Connaught Road 
West, Hong Kong 
Phone 852-2803-2385 Fax 852-2547-5773 
 
BEIJING OFFICE 
Room No. 301 Office Building of Beijing International Club, 
21 Jianguomenwai Avenue, Beijing 100020, China 
Phone 86-10-6532-1850 Fax 86-10-6532-1851 
 
SHANGHAI OFFICE 
27 Hui He Road Shanghai 200437 China 
Phone 86-21-6553-6600 Fax 86-21-6531-4242 
 
SHANGHAI YASKAWA-TONGJI M & E CO., LTD. 
27 Hui He Road Shanghai China 200437 
Phone 86-21-6533-2828 Fax 86-21-6553-6677 
 
BEIJING YASKAWA BEIKE AUTOMATION 
ENGINEERING CO., LTD. 
30 Xue Yuan Road, Haidian, Beijing 100083 China 
Phone 86-10-6233-9943 Fax 86-10-6243-5002 
 
SHOUGANG MOTOMAN ROBOT CO., LTD. 
7, Yongchang-North Street, Beijing Economic Technological 
Investment & Development Area, 
Beijing 100076, China 
Phone 86-10-6788-0551 Fax 86-10-6788-2878  
  
YYEEAA,,  TTAAIICCHHUUNNGG  OOFFFFIICCEE  IINN  TTAAIIWWAANN  
BB11,,  66FF,,  NNoo  5511,,  SSeeccttiioonn  22,,  KKuunngg--YYii  RRooaadd,,  TTaaiicchhuunngg  CCiittyy,,  
TTaaiiwwaann  RR..OO..CC..  
PPhhoonnee::  886666--44--22332200--22222277      FFaaxx::  886666--44--22332200--22223399  
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